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Picarro Notices 

Thank you for purchasing a Picarro product. Your Picarro system is a quality product that has been 
designed and manufactured to provide reliable performance. 

This User Manual (UM) is an important part of your purchase as it will help familiarize you with the 
system and explain the numerous features that have been designed into it. Please read this manual 
thoroughly before using your Picarro system. 

Please contact Picarro or your authorized Picarro distributor should you have questions regarding 
specific applications or if you require additional information. 

DISCLAIMER AND RESERVATION OF RIGHTS 
Picarro has prepared this manual solely for the information and use by its customers as a guide for the 
selection, installation, operation, and maintenance of the products described. 

EXCEPT AS PROVIDED IN THE TERMS AND CONDITIONS OF SALE FOR PICARRO PRODUCTS, 
PICARRO ASSUMES NO LIABILITY WHATSOEVER, AND PICARRO DISCLAIMS ANY EXPRESS 
OR IMPLIED WARRANTY, RELATING TO SALE OR USE OF PICARRO PRODUCTS, INCLUDING 
LIABILITY OR WARRANTIES RELATING TO MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE. 

Picarro reserves the right to change or update the contents of this manual and the specifications of its 
products at any time, without notice. Picarro has endeavored to include information that is current and 
accurate as of the date of the publication or revision of this document, but Picarro does not guarantee 
that this document is error free or that it is accurate with regard to any particular specification. 

Picarro expressly reserves all intellectual property rights, including all intellectual property rights 
relating to any product described in this manual. This document does not grant any license, express or 
implied, by estoppel or otherwise, to any intellectual property rights of Picarro or any third party. 

PATENTS 
The products described in this manual are subject to Picarro patents and patents pending. Information 
about Picarro patents applicable to these products is available at www.picarro.com/company/patents 

TRADEMARKS 
Picarro and the Picarro logo are trademarks of Picarro, Inc. 
Koolance® is a registered trademark of Koolance, Inc. 
Linux® is a registered trademark of Linus Torvalds 
Molex® is a registered trademark of Molex LLC 
SilcoNert® is a trademark of SilcoTek® Corporation 
Snoop® is a registered trademark of Swagelok Company 
Swagelok® is a trademark of Swagelok Company 
Teflon™ is a trademark of the Chemours Company 
 
 
Copyright © 2024 Picarro, Inc. All rights reserved. 
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1. Introduction 

1.1 Intended Use 
The PI5310 analyzer measures concentrations of N2O, CO and H2O using 
Picarro’s patented Cavity Ring-Down Spectroscopy (CRDS). The analyzer can be 
deployed for air monitoring applications in a lab or in the field, allowing in-situ 
analysis of trace and ambient amounts of N2O, CO and H2O. 

1.2 System Overview 
Analyzer 
Figure 1 shows the analyzer front and back panels. More detailed information on 
panel features, functions, and connections are in section 4, Hardware Setup. 

 

 

Figure 1: PI5310 Front/Back Panels 
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Front Panel Operating Status 
The LED indicator on the front panel shows the current operating state of the 
analyzer. Figure 2 describes the status indicator states. The status states and 
colors are also linked to the System Alarm Panel on the CRDS Data Viewer 
Screen. See Section 5 Analyzer Basic Operation. 

 

Figure 2: PI5310 LED Status Indicator 

A2000 Vacuum Pump 
The A2000 vacuum pump (Figure 3) is used to maintain cavity pressure inside the 
analyzer. The pump should be connected and running whenever the analyzer is in 
use. 

   

Figure 3: A2000 Vacuum Pump – Side Views 

1.3 Analyzer Specifications 
Table 1: PI5310 Specifications 

Parameter Specification 

Measurement Technique Cavity Ring-Down Spectroscopy (CRDS) 

Primary Gases Measured N2O (Nitrous Oxide), CO (Carbon Monoxide), H2O 
(Water) 
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Parameter Specification 

Weight: Analyzer 
Weight: Pump 

32.2 kg (71 lbs.) – Should be lifted by two people. 
A2000: 6.5 kg (14.4 lbs)  

Dimensions - Analyzer Length: 76.8 cm (30.25”) 
Width: 42.24 cm (16.63”) 
Width with Rack Mount Rails: 44.78 cm (17.63”) 
Height: 22.23 cm (8.75”),  
Height with Feet: 23.5 cm (9.25”) 

Dimensions – A2000 Pump Length: 27.9 cm (11”) 
Width: 10.2 cm (4”) 
Height: 19.1 cm (7.5”) 

Clearance Front: 15 cm (6”); Rear: 15 cm (6”) 

Ambient Temperature 
Range 

Operating: 10 °C to 35 °C (50 °F to 95 °F)  
Storage: -10 °C to 50 °C (14 °F to 122 °F) 

Ambient Humidity Range < 85% RH non-condensing 

Sample Pressure 300 to 1000 Torr (40 to 133 kPa) 

Sample Flow Rate 200 sccm 

Maximum Altitude  3,048 m (10,000 ft – Operation) 

Required Accessories Included: Pump (external),  
Supplied by Customer: keyboard, mouse, LCD 
monitor 

Operating System  Linux 

Data Outputs RS–232, Ethernet, USB, Data Streaming:  
Optional Analog 4–20 mA 

Installation Benchtop or 48.3 cm (19”) rack mount 

Power Requirements 
 
Mains Supply Voltage 
Fluctuation 

100 – 240 VAC; 50 – 60 Hz (auto-sensing) 250 W 
Max 
 
150 W (pump) ±10% of the nominal voltage 

Minimum Rated Circuit 
Amperage 

10A @ 115 VAC 
5A @ 230 VAC 

Liquid Ingress Protection None 
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1.4 Acronyms 
This manual includes various acronyms. For definitions, see below:  

Table 2: Acronyms, Formulas, Units, and Symbols 

Acronym Definition 

” (as in 1/4”) Inches 

°C degrees Celsius  

< Less Than 

> Greater Than 

A 
Ampere 
Accessory (internal use). Used in model names i.e. A0302 

AC Alternating Current 

cm centimeters  

CO2 Carbon Dioxide 

COM Communication Port 

CRDS Cavity Ring-Down Spectroscopy  

CSV Comma Separated Values 

CPU Central Processing Unit 

DAS Data Acquisition System (the Analyzer) 

DC Direct Current 

DVI Digital Visual Interface 

EMC Electromagnetic Compatibility 

ESD Electrostatic Discharge 

ft. Length in feet;1 ft. = 12” or 12 inches (30.48 cm) 

GUI Graphical User Interface  

H2O Water, Water Vapor 

HDF Hierarchical Data Format  

Hz Hertz 

ID Inside Diameter (i.e., .5” ID) or Identification (i.e., Slave ID) 

kg Kilograms 
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Acronym Definition 

kPa Kilopascal 

lbs pounds 

m Meters or month 

mA Milliampere 

max Maximum 

min Minimum 

mL Milliliter 

mK Millikelvin 

mm millimeters  

N/C No Connection 

NC Normally Closed 

NO Normally Open 

OD Outside Diameter 

P Pressure 

PDF Portable Document Format 

PFA Perfluoroalkoxy – A chemically resistant polymer, suitable for use with 
sticky and aggressive gases 

PN / P/N Part Number 

ppb parts per billion  

ppm parts per million  

PSI (psi) Pounds per Square Inch 

PSIG Pounds per Square Gauge 

Pws Water vapor pressure 

RH Relative Humidity 

RJ-45 Registered Jack (physical network interface) 

RS232 Recommended Standard 232 (serial communication protocol) 

SCCM Standard cubic centimeters per minute 

SS / SST Stainless Steel 
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Acronym Definition 

TCP/IP Transmission Control Protocol/Internet Protocol 

Torr Torricelli (unit of pressure equal to 1/760 atmosphere) 

UM User Manual 

USB Universal Serial Bus 

UPS Uninterruptible Power Supply 

VA Volt Ampere 

VAC Volts of Alternating Current 

VDC Volts of Direct Current 

W Watts 

WLM Wavelength Monitor 

1.5 Text Conventions 
The following conventions are used in the manual. 

• Italic text identifies screen names and emphasizes important text or certain 
features. 

• Bold Italic text identifies section reference links. 

• Bold text is for actions to take (such as clicking on a UI button), caution 
and warning statements, and text you should type or select in screens. 
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2. Safety 

2.1 Warning Symbols 
Icon notes and warnings are used throughout this manual. The purpose of these 
icons is to provide a visual convention to alert you important information. They 
indicate dangers to either the operator or to the analyzer, and other important 
information. 

Table 3: Warning/Information Icon Types 

Icon Description 

 
NOTE 

NOTE is important information that you should be aware of before 
proceeding. 

 
WARNING 

LASER WARNING alerts you of a laser danger. 

 
DANGER 

DANGER indicates an imminently hazardous situation that, if not 
avoided, will result in death or severe injury. 

 
WARNING 

WARNING indicates a potentially hazardous situation which, if not 
avoided, could result in death or severe injury. 

 
CAUTION 

CAUTION alerts user of a potential danger to equipment or to the user. 

 
WARNING 

HAZARDOUS VOLTAGE alerts user to areas that may expose a user to 
electrical energy that is high enough to cause injury or death. 

 
CAUTION 

HOT SURFACE alerts user to potential injury from hot surfaces. 

 
REMINDER 

REMINDER is a helpful hint for procedures listed in the text. 
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2.2 General Safety 
CDRH Certification 
This Picarro Analyzer complies with 21 CFR Chapter 1, sub-chapter J, and is 
classified as a Class 1 laser system when all panels and covers are on. 

CE Certification 
This Picarro Analyzer complies with European safety standards and the 
instrument is affixed with a CE label. This CE label is located on the back panel of 
the instrument. 

• CE: IEC EN61010-1:2010 (safety) and EN61326-1:2013 (EMC) 
requirements for electrical equipment for measurement, control, and 
laboratory use. 

 
WARNING 

Using this analyzer in a manner not specified by Picarro may result in damage to 
the analyzer and render it unsafe to operate. 

 

 
WARNING 

The analyzer is for indoor use only and has an ingress protection rating of IPx-0. 
It is NOT protected against exposure to water including dripping, spraying, 
splashing or immersion. 

 

 
WARNING 

Do not operate in an explosive atmosphere! Do not operate in the presence of 
flammable gases or fumes.  

 

 
CAUTION 

This analyzer contains no user-serviceable components except the particulate 
filter, CPU fan, and A2000 vacuum pump diaphragms and valves. To order user-
replaceable parts and access video replacement instructions, see section 12, 
Maintenance.  

Do not attempt other repairs; instead, report all problems to Picarro Customer 
Service or your local distributor. Please contact Picarro if you have any 
questions regarding the safe operation of this equipment. 

 

 
CAUTION 

Do not replace the mains supply power cord with an inadequately rated cord. 

 

 
WARNING 

If mounting in a 19” rack, this analyzer cannot support itself using a front rack 
mount kit alone. It must be supported by a shelf, or by user-provided “L” type 
support brackets. 
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CAUTION 

Equipment Damage: Exceeding gas inlet pressure or temperature specifications 
could result in damage to the instrument. In the case of higher input pressure or 
flow, configuring a sampling bypass manifold system is recommended. 

Use a ‘tee’ at the gas inlet and exhaust the remainder of the gas stream 
appropriately. 

 

 
WARNING 

The inlet gas connector on the back panel of the Analyzer, and its immediate 
vicinity, runs hot during operation of the analyzer. Take care when connecting 
gas lines or working at the rear of the instrument to wear protective gloves or 
avoid contact with these surfaces. 

 

 
CAUTION 

Equipment Damage: Do not disconnect the AC power to the analyzer, vacuum 
line, or the AC power to the External Vacuum Pump while analyzer is operating. 
Damage may be caused by current surges if power is applied while attaching or 
removing cables. 

 

 
WARNING 

This analyzer weighs 32.2 kg (71 lbs). Use the technique described below (or 
follow your local regulations) when lifting the analyzer. 

• Before lifting, inspect the unit for slippery substances or sharp edges. 

• Lift with two people, one on each side of the analyzer. 

• Crouch down and stay close to the unit. Always keep your back as 
straight as possible.  

• Position your feet for sturdy balance. Lift with your legs, not your back.  

• Do not twist the back while carrying the unit. Rotate direction with hip 
joints.  

• Lower the unit by bending at the knees.  

2.3 Laser Safety 

 
WARNING 

This equipment is classified as a Class 1 laser product with an embedded 3B 
laser in accordance with EN 60825-1:2014. Do not to open the enclosure where 
this label is placed; there are no user serviceable parts inside. 

The following Laser Safety Label is affixed to the outer cover of the analyzer. 

 

Figure 4: Laser Safety Label – Affixed to Outside Cover of Analyzer 
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WARNING 

The laser is a Class 3B when exposed.  
Only operate or service this device in accordance with the instructions in this 
guide, and only open the device in an approved laser safe service area using 
appropriate laser-safety glasses. 

The following Laser Safety Label (Figure 5) is affixed to the inside of the analyzer: 

 

Figure 5: Laser Safety Label – Affixed to Inside of Analyzer 

 
CAUTION 

Use of controls or adjustments or performance of procedures other than those 
specified herein may result in hazardous radiation exposure. 
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3. Unpacking 

3.1 Inspect the Shipping Container 
Picarro products are inspected and tested before leaving the factory. Their 
packing containers have been designed to keep the equipment safe from damage 
during transit. 

Picarro SI5000 series shipping containers consist of: 

• A wooden crate with metal clamps 

• Layers of protective foam 

           

Figure 6: Shipping Container with Clamps Installed/Removed 

1. To open the crate, use a claw hammer to remove the metal shipping 
clamps. 

2. Inspect the condition of the crate and packing materials upon arrival. 
The crate houses the analyzer and the external pump. Even if the crate 
shows some external damage, it will protect the instrument under most 
circumstances. 

If the equipment inside the container does appear to be damaged, 
photograph all the evidence of damage and contact Picarro, sending the 
photographs as soon as possible. 

3. Keep all packing materials so the instrument can easily be returned 
Picarro if necessary. 
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3.2 Unpack Components 
While unpacking each shipping box: 

• Inspect each item to ensure it is not damaged.  

• If items are missing, contact Picarro. 

• Keep the shipping materials to reuse when transporting the analyzer. 

• Contact Picarro for options on transporting systems to remote labs. 

 
WARNING 

The analyzer weighs 32.2 kg (71 lbs). Use the technique outlined on Page 20 
when lifting or moving the analyzer.  

 

 

Figure 7: PI5310 Shipping Box Contents 

USB 
Backup 

Software 

Analyzer 

A2000 Pump to Analyzer 
Vacuum Hose 

A2000 Vacuum Pump 

Control Cable 
for External 
Solenoid 
Valves 

Connectors 
for Control 
Cable 

User Manual 

Slide Rails 



   Unpacking 

24 P/N 40-0103 Rev. A PI5310 UM 

Table 4: PI5350: Shipping Container Contents 

Item (qty) Description 

Analyzer (1) Includes all the data acquisition, control, and 
communications hardware and firmware to perform 
all gas handling, spectral collection, and analysis. 

Vacuum Pump (1) Provides vacuum required for sample gas 
sequencing into and out of the analyzer. 

Vacuum Hose (1) Hose to connect the pump to the analyzer. 

AC Power Cables (1) A power cable with connectors appropriate to your 
country is provided; one for the analyzer and one for 
the pump.  
Note: The analyzer automatically adjusts to local 
voltage, but the vacuum pump voltage must be 
selected. See Section 4.3, Analyzer Preparation. 

Slide Rails 1 Pair of slides and hardware for 19” rack mounting. 

Control Cable Kit (1) For external solenoid valves. 

Nut (1) and Ferrules (2) For connecting input line to analyzer gas input. 

Coolant 1 bottle of Koolance 702 liquid coolant. 

Document Packet (1)  Includes this user manual and certificate of 
compliance (not shown). 
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4. Hardware Setup 
Read this entire section before proceeding. Refer to Figure 16 in the following 
section for installation. 

4.1 Items/Tools Required 
• 9/16’’ open end wrench 

• 11/16’’ open end wrench 

• Phillips head screwdriver (for rack mounting) 

• 2.5 mm Allen wrench (for rack mounting) 

• Pump 

• Power Cord for analyzer and pump 

• Coolant for chiller 

4.2 Installation Safety 

 
WARNING 

Two-person lift required: The analyzer weighs 32.2 kg (71 lbs). When lifting the 
analyzer, use the technique described on Page 20 (or follow your local 
regulations).  

 

 
CAUTION 

When the analyzer is being integrated to an external system, the safety of that 
system is the responsibility of the assembler of that system.  

 

 
WARNING 

Equipment Damage: Do not attach electrical power to or start the analyzer until 
after attaching and turning on the External Vacuum Pump. Do not disconnect the 
vacuum line while the analyzer is running. Failure to do so could result in 
damage to the optics. 

 

 
WARNING 

Picarro sells certain USB enabled devices, such as GPS, which are approved for 
use. Do not connect USB hubs or unauthorized USB devices (except flash 
drives, mice, and keyboards) to the USB ports. Unauthorized USB devices may 
interfere with the normal functioning of the analyzer. 

 

 
Warning 

When using compressed gases, follow all appropriate safety conventions, 
including use of eye protection, physical restraint of cylinders, etc. 
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CAUTION 

Lines connected to the 1/4” Swagelok sample inlet connector must not exceed 
15 PSIG of pressure. 

 

 
WARNING 

Operating at concentrations above the intended ranges may render the 
instrument unsafe to operate, maintain, service or dispose of. 

 

 
WARNING 

Any light emitted from the front panel Status Indicator, regardless of color or 
state, shown in Figure 14 indicates one or more lasers are on. 

 

 
CAUTION 

During installation, do not position the analyzer so that it is difficult to operate 
the electrical disconnecting device (such as an emergency off (EMO) switch or 
breaker). 

 

 
WARNING 

If mounting in a 19” rack, this analyzer cannot support itself using a front rack 
mount kit alone. It must be supported by a shelf, or by user-provided “L” type 
support brackets. 

 

 
CAUTION 

Use the AC power cables supplied with the analyzer or a similarly rated cable. 
Check with Picarro technical support if you have questions about power cable 
replacement. An inadequately rated power cable can result in equipment 
damage. 

 

 
CAUTION 

Cords shall be RATED for the maximum current for the equipment and the cable 
used shall meet the requirements of IEC 60227 or IEC 60245. Cords certified or 
approved by a recognized testing authority are regarded as meeting this 
requirement. The connector type used should be: IEC320 C13. 

 

 
CAUTION 

If the analyzer has been stored at less than 10 °C, allow the components to 
equalize to room temperature before starting the installation process. 
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CAUTION 

Equipment Damage: It is imperative that the analyzer have adequate ventilation 
and/or cooling to maintain the ambient temperature below 35 °C when operating. 
Do not place the pump or the instrument in any enclosure without providing 
adequate forced air flow. 
Do not plug or block any perforations in the chassis of the instrument. Do not 
put anything near the instrument that will impede the air flow. Failure to provide 
adequate airflow, especially clearance at the front and rear panels, to ensure 
proper airflow and/or cooling to the analyzer will result in overheating of the 
analyzer causing a shutdown and potential damage. There should be 6” (15 cm) 
of clearance in the front and back of the analyzer. 

To determine if the ventilation is adequate in an enclosure, monitor the 
temperature of the air near the instrument and adjust ventilation so that the 
ambient temperature is within specification. As a guide, the ambient temperature 
of the air around the instrument cannot exceed the specifications listed below. 

Thermal Specifications Min Max Description 

Ambient Operating 
Temperature 

10 °C 35 °C Worst-case environmental limits 
(unless otherwise specified) 

 

4.3 Analyzer Preparation 
Ventilation Considerations 
The instrument and pump require adequate ventilation in order to function 
properly. Do not plug or block any perforations in the chassis of the instrument. 
Don’t place anything near the instrument that will impede the air flow.  

Positioning 

 
NOTE 

The unit is shipped with rubber feet installed for benchtop use. Alternatively, it 
can be mounted in an equipment rack using the drawer-style rails included in 
the shipping crate. If the rails are used, the rubber feet must be removed so the 
unit can fit in a standard 5U rack opening. For instructions, see Section 4.5, 
Rack Mount Instructions 

4. Remove the analyzer and the external vacuum pump from the shipping 
container. 

5. Install the analyzer in a rack or place it on a cart or table. 

6. Place the external vacuum pump near the analyzer in a rack, or on a 
cart or table. 
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CAUTION 

If you rack-mount the analyzer, be sure to support it with a shelf or the provided 
rails; the analyzer cannot support itself on the front rack mounting brackets 
alone. 

 
7. Unpack the analyzer accessories (vacuum line, cable kit, manual, and 

certificate of compliance). 

 
NOTE 

Store the certificate of compliance in a safe place. It may be required if you 
contact Picarro for service or questions. 

8. Remove the caps from the analyzer Sample inlet and Vacuum 
connection ports.  

9. Remove the caps from the pump vacuum inlet. Save the caps for reuse 
in case the analyzer and pump is stored, moved, or shipped. 

Set A2000 Pump Input Voltage 
10. If using an A2000 vacuum pump, set its input voltage to the correct level 

for your area by rotating the voltage selector switch located on the side 
of the pump next to the fuse holder (Figure 8). 

 

Figure 8: Vacuum Pump Voltage Selection 

4.4 Connections – A2000 Pump and Gas Inlet 
Follow instructions in this section when using an A2000 pump with your analyzer. 

Pump Connections 
Refer to Figure 9 when using an A2000 pump with your analyzer. 

Input Voltage Selector 
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Figure 9: Analyzer Setup with A2000 Pump 

 
CAUTION 

When working with hazardous gases, remove the pump exhaust muffler and 
adapt a tube to the vacuum pump exhaust port (shown in Figure 9) and direct the 
exhaust to a safe place for venting the mixture of sample gases. For 
instructions, see APPENDIX F – Setting up Contained Exhaust Flow. 

1. Connect the provided vacuum line between the analyzer port labeled 
VACUUM and the pump vacuum inlet.  

2. If working with hazardous gases, see APPENDIX F – for instructions on 
directing the pump exhaust to a safe venting environment. 
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Sample Gas Inlet Connections  
There are two types of sample Inlet connections which are model-dependent.  

• Analyzers that have stainless steel (SST) sample inlet connectors. 

• Analyzers that have PFA sample inlet connectors. 

Sample Gas Inlet Connection (SST Tubing) 
1. Use 1/4” OD SST tubing and connector sets to connect from sample 

source to the sample inlet. 

2. Place the two ferrules inside the nut as shown below. 

 

Figure 10: Orientation of Inlet Nut and Ferrules (SST Tubing) 

3. Loosely connect the nut to the INLET on the back panel of the analyzer, 
being careful not to let the ferrules fall out. 

4. Insert the tubing into the back of the nut and through the ferrules, 
feeding it in as far as possible without deforming the tubing. 

5. Hand tighten the nut. 

6. Using a 9/16" wrench (not included), tighten the nut 1-1/4 turns. 

When reconnecting SST tubing 

7. Inspect the ferrules. If you see any damage, replace the ferrules and 
follow the directions above for making a new connection. 

8. If there is no damage, hand tighten the connector to the analyzer 
sample inlet. 

9. Using a 9/16" wrench, tighten the nut 1/6 of a turn (60°). 

Sample Gas Inlet Connection (PFA Tubing) 
When making a new PFA gas inlet connection:  

1. Use 1/4” OD PFA tubing and connector sets to connect from sample 
source to the sample inlet. 

2. Place the two PFA ferrules inside the PFA nut as shown in Figure 11. 
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Figure 11: Orientation of Inlet Nut and Ferrules (PFA Tubing) 

3. Loosely connect the nut to the INLET on the back panel of the analyzer, 
being careful not to let the ferrules fall out. 

4. Insert the tubing into the back of the nut and through the ferrules, 
feeding it in as far as possible without deforming the tubing. 

5. Hand tighten the nut. 

6. Using a 5/8" wrench, tighten the nut 1-1/6 turns (1 full turn plus another 
60°). 

When reconnecting PFA tubing 

1. Inspect the ferrules. If you see any damage, replace the ferrules and 
follow the directions above for making a new connection. 

2. If there is no damage, hand tighten the connector to the analyzer 
sample inlet. 

3. Using a 5/8" wrench, tighten the nut 1/6 of a turn (60°). 

4.5 Rack Mount Instructions 
When mounting the analyzer in a standard 5U rack opening, use these 
instructions. 

 
WARNING 

If mounting in a 19” rack, this analyzer cannot support itself using a front rack 
mount kit alone. It must be supported by a shelf, or by user-provided “L” type 
support brackets. 

1. Remove the rack-mounting rails from shipping crate and remove 
packaging. 

2. Extend each rail. Press the blue PUSH HERE button and remove the 
narrow inner slide from the assembly. 
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Figure 12: Inner Rail Slide Removal 

1. Attach the inner slide to side of of the analyzer (Figure 13) using four 
included M4 x 8 button-head screws. 

2. Repeat on the other side of the analyzer. 

 

Figure 13: Attaching Inner Slide Rails to Analyzer 

3. Attach a front panel restraint (Figure 14) to each side of the analyzer 
using two included M4 x 8 button-head screws. 

Inner Slide 

Press to 
Release 
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Figure 14: Locking Bracket Installed 

4.  Mount the outer rails to the rack (Figure 15) using supplied hardware at 
each end, or according to rack design. 

 
NOTE 

Equipment racks vary, and some customization may be necessary. 

 

 

Figure 15: Outer Rail Mounted to Rack 

5. Remove the rubber feet from the analyzer using a Phillips screwdriver. 
This may be necesssary to prevent clearance issues with adjacent 
instruments within the rack. 

 
WARNING 

This analyzer weighs 47 lbs (21.3 kg) When lifting the analyzer, use the 
technique described in the Safety section of this document (or follow your local 
regulations) . 

Locking Bracket 
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6. Using two people to lift the analyzer, engage inner rails on analyzer with 
outer rails in rack, and slide analyzer into place. 

7. Secure the locking brackets (Figure 14) to the rack frame. 

4.6 Electrical Connections  
 Refer to Figure 16 for connection points. 

 
NOTE 

This section is designated as Electrical Safety Task Type 2: Equipment is 
energized. Energized circuits are covered or insulated. 

 

 

1. External Vacuum Port to Vacuum Pump 
2. Gas Sample Inlet 
3. Analyzer pressurized air inlet connection 
4. Solenoid valve cable connection 
5. On/Standby switch with indicator LED 
6. 4-20 mA Output screw terminal block 
7. Rocker power switch 
8. AC Line power receptacle 
9. Ethernet Ports – RJ-45 (2 ea.) 

10.  USB-2 Ports 
11.  DVI-D Video Monitor Port 
12.  Serial port for command interface (COM1) 
13.  Serial port for streaming data (COM2) 
14.  Ground binding post 
15.  HDMI Port 
16.  Display Port 
17.  USB Ports (4 ea.) 
18.  Audio In/Out Ports 

Figure 16: Annotated Rear Panel Diagram 
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1. Connect a monitor to the HDMI port at the back panel. The analyzer will 
detect the connection and adjust the resolution to match the monitor. 

2. Connect a mouse and keyboard to a pair of USB ports. 

3. Connect the provided AC power cable from the analyzer to the power 
source. 

 
NOTE 

The analyzer has a universal power supply that automatically adjusts to power 
sources ranging from 100-240 VAC, 50/60 Hz, 10 A max. 

 

 
NOTE 

The A2000 pump does not automatically adjust to power sources. If using the 
A2000 vacuum pump, ensure its input voltage is set to the correct level for your 
area by rotating the voltage selector switch located on the side of the pump next 
to the fuse holder (see Figure 6). 

 
4. Check that the A2000 pump voltage input switch is set correctly. 

5. Connect the provided AC power cable from the vacuum pump to the 
power source. 

6. If used, connect the valve cable from the analyzer back panel to any 
solenoid valves. 

7. If used, connect rotary valve (A0311 or A0311-S) to COM2 with its 
provided serial cable. 

4.7 Chiller Laser Cooling 
A chiller with a 50 mL water buffer tank is installed for reliable and efficient laser 
cooling. Please note the following: 

• The coolant in the buffer tank is partially filled when shipped. Follow the 
instructions below before you begin measurements.  

• Instrument must be powered off for water tube reconnections and water 
fill, refill, or drain. 

• Check and confirm the flowing movement of coolant every six months or 
whenever a disconnection and reconnection of the buffer tank occurs. 

• Inspect the water level in the reservoir every six months; add or refresh 
coolant in case of water loss or contamination. 

• A bottle of coolant (manufacturer: Koolance, part number: LIQ-702CL-B) is 
shipped with the analyzer.  
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• Do not use water as coolant. Contact Koolance (https://koolance.com) for 
replacement bottles. Koolance has re-sellers in Asia, Australia, Europe, 
Canada, and the United States. 

• The safety data sheet for LIQ-702CL-B is included in APPENDIX J – SDS 
for Koolance LIQ-702. 

Chiller Setup 
1. Inspect the water buffer tank for possible cracks, and external water 

tube breakage.  

 
WARNING 

If damage is observed, stop, and contact Picarro support to get the damage 
repaired before adding coolant. 

 

 

Figure 17: Reservoir Connections at Time of Shipment 

2. Rotate the black top lid counter-clockwise to open the tank as shown in 
Figure 18. 
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Figure 18: Reservoir Inspection 

3. Fill the reservoir so that the coolant covers the sponge and reaches the 
last thread for the top lid. See Figure 19. 

 

Figure 19: Proper Coolant Level in Reservoir 
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4. Disconnect the quick connect fittings shown in Figure 17. To release the 
quick connect fittings, push down on the metal tab of one fitting and pull 
the fittings apart. Attach each fitting to the bottom of the reservoir as 
shown in Figure 20. 

 

Figure 20: Reservoir Connected and Ready to Run 

5. Power on the analyzer per Startup, Section 5.1 and check the coolant 
level while flowing. If the level drops below the level of the sponge in the 
reservoir, add coolant to full level directly from either one of two top 
venting ports. 

6. To inspect the coolant flow, open the tank as shown in Figure 21, use a 
hex drive or a long pin to pinch the sponge, and reveal the two openings 
on the bottom of the reservoir. Make sure bubbles are forming. 

 

Figure 21: Confirmation of Coolant Flow 

7. Replace the lid and tighten it clockwise. 



Hardware Setup   

PI5310 UM P/N 40-0103 Rev. A 39 

 
WARNING 

To turn off the analyzer, follow Shutdown, Section 5.2. Never remove the vacuum 
while the system is running. Doing so can damage the instrument which is not 
covered under warranty. 

Chiller Maintenance 
With TEC chiller, one buffer tank containing circulation coolant fluid is used for 
effective laser heat dispersion. The general industrial heat transfer medium, 
Koolance LIQ-702 is used, see APPENDIX J – SDS for Koolance LIQ-702.  

The coolant should be maintained in proper level with refilling, or replacement if it 
is contaminated. 

 
NOTE 

Coolant level should be checked monthly on its level which is due to 
evaporation or other loss. If the level is no more than half of full tank and the 
liquid is clear, adding coolant is needed. 

Adding Coolant 

Open the top two sealing ports, add only proper coolant to its maximal level of 
coolant buffer tank. This can be done when the analyzer is in operation. 

 
NOTE 

Coolant clarity should be checked annually. The turbid coolant liquid indicates 
contamination. If the liquid is not transparent and the sponge in dark yellow, 
coolant replacement is needed.  

Coolant Replacement 

Approximately 50 mL of fresh coolant is needed. Use the following procedure to 
replace the coolant within the chiller. 

1. Turn off the analyzer. 

2. Disconnect the two quick connectors from the bottom of the buffer tank. 

3. Remove the tank from its holder, open the top lid, dump all coolant, 
wash the sponge. 

4. Install tank back to its folder, put sponge back, seal top lid 

5. Open the two top sealing ports, add coolant to full level. 

6. Connect the two quick connectors fully back to position. Make sure there 
are no kinks along the tubes. 

 
NOTE 

The reference coolant flow rate is typically as 0.25 lpm (liter per minute). A 
minimal flow rate of 0.15 lpm or above is required for laser cooling. 
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5. Analyzer Basic Operation 
This section explains how to operate the analyzer using the GUI. It describes system 
startup, shutdown, and recovery procedures, desktop features. GUI Functions are 
detailed in section  

 
WARNING 

Using this analyzer in a manner not specified by Picarro may result in damage to 
the analyzer and render it unsafe to operate. 

 

 
CAUTION 

During operation, do not position the analyzer so that it is difficult to operate the 
electrical disconnecting device (such as an emergency off (EMO) switch or 
breaker). 

 

 
NOTE 

The illustrations shown in this chapter are for example only. What is shown on 
your instrument is dependent on the model analyzer in use and may differ. 

5.1 Startup 
1. Make sure the pump vacuum hose is connected between the analyzer 

and pump. 

 
CAUTION 

Always turn on the external pump before powering up the analyzer. This ensures 
a safe start-up sequence. 

2. Verify the power cable to vacuum pump is plugged in. 

3. Switch power on at the pump. 

4. Verify the power cable to the analyzer is fully inserted into the power 
receptacle. 

5. At the analyzer back panel, press the main power switch to the ON ( I ) 
position. 

6. Press the round On/Standby button on the rear panel. The LED 
indicator (Figure 2) illuminates green. 

The software starts automatically, and the analyzer displays the Picarro 
Launch Pad as shown Figure 25. 
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NOTE 

On a cold start, upon reaching this screen, there will be a 30-second countdown, 
after which the analyzer will automatically start in CRDS mode, or the previous 
selection if manually overridden. The user can click anywhere or click any key 
on the keyboard to stop the countdown. To start the CRDS Data Viewer 
manually, see the section Home Menu. 

When initialization is complete, the CRDS Data Viewer GUI displays and provides 
displays graphs for N2O, CO, and H2O as shown in Figure 22. This section 
describes the Data Viewer, the analyzer’s main screen. 

After the Data Viewer loads, the analyzer warms up before starting 
measurements. During this warmup period the System Alarm box flashes yellow 
and the Cavity Temperature, Cavity Pressure, and Box Pressure displays. For 
more information, see section 6.5 Instrument Status. 

When the analyzer is warm, the data screens switch to displaying N2O, CO, and 
H2O concentrations. The System Alarm box becomes solid green and a 
‘Measuring…’ message displays in the Measurement Status field.  

Analyzer initialization is complete, the Data Viewer screen displays, and sampling 
begins. Figure 22 shows the Data Viewer measurements for nitrous oxide, carbon 
monoxide, and water. 

Data is saved automatically whenever the analyzer produces data. The data 
displayed on the CRDS is the continuous real time read-out from the analyzer. A 
user-relevant subset of this data is stored in: 

/home/picarro/I2000/Log/Archive/YYYY-MM-DD/DataLog_User/  

where Y = year, M = month, D = day. Further details can be found section 8, File 
Management. 

In order to measure discrete samples (such as individual gas bags) or from 
multiple locations (when switching valves draw in ambient air from different 
heights) a separate software window (coordinator) is used to control the sample 
source and match the corresponding real time read out with the sample source. 
Depending on system configuration, coordinator programs may not be included. 
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Figure 22: GUI/Data Viewer Screen 

5.2 Shutdown  
This section describes how to safely shutdown the analyzer using dry gas, closing 
the CRDS application, and powering off the instrument from the Picarro Launch 
Pad. 

 
CAUTION 

A flow of clean, dry gas should always be directed to the instrument for several 
minutes prior to shutting down. Trapping a high-moisture content gas sample in 
the cavity can cause condensation damage to the mirrors as the instrument 
cools from its operating temperature. 

 

 
CAUTION 

Do not turn off the pump or disconnect the vacuum line while the instrument is 
operating. 
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Flow Clean, Dry Gas (When Using an A2000 Pump) 
7. With the pump still running, switch to a source of clean, dry gas at the 

sample inlet and allow it to run until the water channel reading on the 
GUI falls below 2000 ppm. This will prevent any damage from 
condensation to the cavity surfaces. This dry gas may be from a tank 
(target 2-3 PSIG pressure) or from a desiccant column like the DrieRite 
column, C0360, sold on store.picarro.com). 

Shutdown (CRDS Data Viewer) 
8. Click on the Quit button from the botom left side of the Data Viewer 

window. 

9. A message displays prompting the user to confirm the shutdown. Once 
confirmed, the analyzer software and hardware will turn off. 

Note you must be logged in to shut down the analyzer. 

 

Figure 23: Analyzer Shutdown Dialog 

 

10. Manually turn off the pumps and dry gas only if system requires it. 

 
NOTE 

Leave any dry gas or desiccant attached to the inlet during this process. 

11. From the Picarro Launch Pad select Power Off to tun off the hardware. 

12. When the instrument fans audibly turn off, and when the green power 
button light on the front of the instrument turns off, shut off the pump 
manually from the rocker switch located on the pump. 
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5.3 Analyzer Restart after Electrical Power Outage 
If power to the analyzer is cut-off for any reason the analyzer will cease operation. 
However, when the power is reapplied, the analyzer will restart automatically, the 
Picarro software tools will properly close out previous files and open new files for 
data collection so that previously collected data, instrument diagnostics and other 
parameters recorded up to the time of power outage are retained. 

If short power outages are common in the user location, Picarro recommends 
using an uninterrupted power supply (UPS) to protect the data stream and the 
health of the cavity. 

5.4 Picarro Launch Pad 
The Picarro Launch Pad is the entry point for starting and using the analyzer. It 
provides access to the CRDS Data Viewer, tools, configuration settings, and 
administrative controls for the instrument such as managing user accounts. This 
section provides an overview of the Picarro Launch Pad’s key features with 
additional information throughout this manual. 

Home Menu 
When the analyzer is powered on the Picarro Launch Pad automatically starts and 
displays the Home menu. To manually start the analyzer from the Picarro Launch 
Pad, single click on the N2O-CO button or wait 30 seconds while the acquisition 
software auto starts and initializes as shown in Figure 24. 

 

Figure 24: Picarro Launch Pad/Loading Screen 
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Use the buttons on the Home screen to use the following features as shown 
Figure 25. The Files, Config, Service, and Power Off buttons are password 
protected to prevent accidental shutdown or configuration changes.  

 

Figure 25: Picarro Launch Pad/Home Menu 

The Home menu provides the following options: 

• N2O-CO – Starts the analyzer in normal operation. 

• Files – Copies data to an external device (user credentials required). See 
the following Files Manager section for more information. 

• Power Off – Performs a soft shutdown (user credentials required). 

File Manager 

The File Manager is accessible from the Picarro Launch Pad from the Home 
menu or directly from the CRDS Data Viewer Tools menu using the Files button. 
Follow the procedure to copy data to an external drive.  

1.  On the home page, click on Files. 

2. Login using user credentials.  

3. Plug in an external USB drive. 

4. In the bottom right-hand corner, select mount and choose the desired 
drive. After selecting, files will be populated on the right side with from 
the USB drive 

5. Using the upper left-hand corner drop down menu, select the type of 
file: Data, Screenshot, User History, Validation Report. 
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6. Highlight and select the desired files. 

7. Click Copy to copy or move to transfer file to USB drive. 

8. Unmount the USB drive when file transfer/copy is complete. 

 

Figure 26: Transfer Files Dialog 

Configuration Menu 
The Configuration menu provides access to various tools and configuration 
settings. This section describes the Configuration menu’s features and is 
accessible by performing the following procedure. 

1. Shut down the data viewer software by clicking the Quit button and 
allow the analyzer to return to atmospheric pressure and stop 
measurements. 

2. From the home screen, click on the Config button to configure the 
analyzer.  

3. Log in with a user name and password. Note a user account with 
appropriate access is required. 
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Figure 27: The Config Login Dialog 

4. The Configuration Menu displays.  

 

Figure 28: Configuration Menu 
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NOTE 

If the analyzer is operating in measurement mode, only DataViewer and User 
options are accessible from the Config menu. To access the full menu, restart 
the analyzer or stop measurement mode by selecting Shift key from the 
keyboard and clicking the Quit button from the CRDS Data Viewer. 

 
Network 

Click the Network button to view the Network Settings Tool. Note requires login. 

  

Figure 29: Login: Network Settings Tool 

The Network Settings Tool displays. 

 

Figure 30: Network Settings Tool 
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Use the Network menu to: 

• Select ethernet adapter  

• Select IP address type 

• If Static IP is selected, enter the applicable address, netmask, gateway, 
and/or DNS server 

• View the network connection status and active IP address 

Clock 

Click the Clock button; the Set Time and Time Zone dialog displays. 

 
NOTE 

The time can only be changed when the analyzer has just been turned on from 
being completely off, and before the data acquisition warm-up process begins. 

 

  

Figure 31: Clock Set Dialog 

Use the Clock dialog to: 

• Set the clock for a new time zone. 

• Manually set the correct time. 

Set the Local Time Zone 

1. Click on the Local Timezone drop-down and select the location you 
want. The Local Date/Time field changes to the date and time for the 
location you selected. 

2. Click Set to save the changes and return to the Config menu. 



   Analyzer Basic Operation 

50 P/N 40-0103 Rev. A PI5310 UM 

 

Figure 32: Clock Set Menu 

Manually Set the Time 

Use the Set Time Manually check box to manually reset the clock to the correct 
date and time when the clock is set to the wrong time. 

1. Check the Set Time Manually check box. 

2. Click Set to save the changes and return to the Config menu. 

 

Figure 33: Clock Set Dialog 
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DatViewer 

The Data File Viewer software allows concatenating multiple files into one file to 
provide historical trends over a specified time of measurement. For detailed 
information, see APPENDIX E – Data File Viewer. 

Serial Port 

Allows configuration of the ASCII Serial Port by setting the Data Out and 
Command Interface parameters that are used for RS-232 serial communication. 
For more information about the about the Serial Port menu, see Chapter 10, 
Serial Communication. 

Users 

Provides access to the User Management Tool for managing user accounts, 
security settings and user history. Requires a password to obtain entry. For more 
information, Chapter 7, User Management. 

Modbus 

Allows configuration of the Modbus communication protocol. For more 
information, see Chapter 9, Modbus Communication. 

Backup Restore 

Provides a mechanism for backing up and restoring system settings. 

Service Menu 
The service menu is password protected and allows for service tasks to be 
performed by trained Picarro personnel only.  
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6. List of GUI Functions 

 
NOTE 

The illustrations shown in this chapter are for example only. What is shown on 
your instrument is dependent on the model analyzer in use and may differ. 

6.1 GUI Overview 
The features of the GUI in Figure 34 are described in the following sections. 

 
1. Users, View, Tools, and Help menus 
2. Digital Readouts and Statistics 
3. Instrument Status 
4. Alarm Panel 
5. Quit Button 
6. Data Log; Filename, and Path 

7. Status Log Window 
8. Data Source, Data Key, and Precision  
     pull-down menus for data window content 
9. Axis Auto Scaling 
10. Reset Data Buffer 
11. Data Buffer Level Meter 
12. Data Windows 

Figure 34: Layout of PI5310 Analyzer GUI 
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6.2 Users, View, Tools, and Help Menus 

 

Figure 35: CRDS Toolbar Options 

User Menu 
Left clicking on the Users menu displays the drop-down User Login or User 
Logout. Depending on your level of access, different menu items are enabled. 

View Menu 
The View menu provides the following options that can be enabled. Note that 
when toggled on, a checkmark displays to indicate the enabled feature. 

• Lock/Unlock time access when zoomed – When locked, forces the data 
windows to display the same time scale during zoom. 

• Show/hide Statistics – Displays the measurement statistics. 

• Show/hide Instrument Status – Displays the instruments status. 

Tools Menu 
Use the Tools drop-down menu to plot data, copy data, perform user admin tasks, 
calibrate the instrument, or show/hide the valve sequencer GUI. The Tools menu 
features are as follows: 

• DatViewer – Allows plotting of data saved in *.dat and *.h5 files. 

• Files – Copies data to an external drive using the File Manager. 

• User Administration – Provides access to User Management options for 
managing user accounts, policies, viewing histories and profiles. 

• Analyzer User Manual – Opens the user manual in PDF format. 

• Show Valve Sequencer GUI – Toggle to display the external valve 
sequencer window (use alt-tab to bring it to the front). 

Help Menu 
About: Displays the version number of the instrument. 
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6.3 Alarms Panel 
This panel is used to monitor the status of the internal instrument alarms. These 
indicators are gas concentration alarms, such as “N2O Too High/Low” depending 
on instrument configuration. The gas concentration alarm icons are off (grayed) 
when the respective concentrations are below a certain value, and they are 
illuminated red when the respective concentrations are above/below a certain 
value.  

 
CAUTION 

High/low alarm settings are not intended as a safety measure as configured at 
the factory, either with respect to human health or the health of the analyzer. It is 
up to the customer to determine the meaning and level of a “high” or “low” value 
based on their application. 

 

 

Figure 36: Alarm Panel 

Alarm Panel Indicators are colored as follows: 

• System Alarm: 

• Green when the analyzer is measuring properly 

• Flashing Yellow when the analyzer is warming up 

• Yellow when not warming up properly 

• Red when not operating properly 

• Measurement Range Alarm: 

• Green when concentration is within analyzer measurement range 

• Red when above analyzer measurement range 

• Custom Range Alarm: 

• Green when within boundaries set by the user 

• Red when not within boundaries set by the user 

• Grey when alarm is disabled by the user (these are disabled by 
default) 



List of GUI Functions   

PI5310 UM P/N 40-0103 Rev. A 55 

To view the alarm set points for a gas, click on the indicator next to that gas. The 
Alarm Set dialog displays.  

 

Figure 37: Alarm Set Dialog 

This features allows reading or changing the alarm settings and the ability to 
enable it or change the set point. The indicator illuminates when the concentration 
goes above the set point and resets (indicator off) below the set point. The alarm 
modes for gasses are: 

• Higher 

• Lower 

• Inside 

• Outside 

Type the value you wish to set the alarm to and click the OK button or Cancel if 
you do not wish to change the alarm value. If you do nothing, the dialog box will 
disappear, and the alarm value will remain unchanged. The units are those that 
appear in the GUI graph.  

6.4 Digital Readouts 
Displays the latest value recorded for the selected Data Key for each Data 
Window. Changing the Data Key changes the Digital Readout as well as the Data 
Window view. 
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If the Show Statistics entry is enabled in the View menu, the mean, standard 
deviation, and slope of the data in the graph is dynamically calculated and 
indicated below the digital concentration readout. These numbers change to 
reflect statistics of whatever data is in the data window. Zooming into a section of 
existing data will show the statistics statically for that time period, while the digital 
readout above the statistics continues to update with the latest value. See section 
6.13, Graph Zooming for more information. 

  

Figure 38: Digital Readouts Panel 

6.5 Instrument Status 
If these parameters are enabled through the Show Instrument Status entry in the 
View menu on the main toolbar, digital readouts for Warm Box temperature, 
Cavity Temperature, Cavity Pressure, and Box Pressure are displayed to the left 
of the main trend graphs. 

 

Figure 39: Instrument Status Panel 

With Show Statistics 
Enabled 

With Show Statistics 
Disabled 
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6.6 Shutdown and Stop User Log(s) Buttons 

 

Figure 40: Shutdown/Stop User Log 

Quit Button: 
Shuts down the analyzer. See section 5.2 Shutdown. 

Restart User Log(s) Button 
The Analyzer automatically records all data collected on the instrument as .dat 
files. These are described further in section 8, File Management. 

To start a new data file (time-coded to the current second), click the Restart User 
Log(s) button. The new file name should be visible beneath the button in a few 
seconds. 

Data Log Filename and Path 
The filename and path of the active data log is displayed in this pane. The 
indicator is grayed-out when there is no active data log before gas measurement 
reporting begins. A new file is generated when the instrument starts reading gas 
concentrations, (e.g., “153719”) and subsequently at 1 hour increments (e.g., 
“163719”, “173719”). A new day folder (e.g., “2021\07\16”) will be generated at 
midnight, as will month and year folders at the appropriate times. 

 

Figure 41: Data Log Filename and Path Panel 

6.7 Data Window 
The data window displays a graph of any stream of data vs. system time, with a 
format of hh:mm:ss. The user can select which data streams are displayed using 
combinations from the Data Source and Data Key pull down menus. The 
precision displayed can be adjusted using the Precision menu. Auto-Scaling of the 
Y-axis is also available. Clicking any Autoscale button autoscales its Y-axis if the 
plot hasn’t done this automatically. 
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Figure 42: Data Window Panel for N2O, CO, and H2O 

6.8 Data Source and Data Key Pull Down Menus 
Data Source and Data Key menus (Figure 43) enables selection of the data 
stream that is viewed in the data window.  

• Gas concentrations if ‘instrument Analysis’ (where instrument represents 
the system installed) is selected. 

• Sensor Readings: If “Sensors” is selected, the analyzer’s optical cavity 
pressure or temperature can be viewed, as well as the temperature of the 
electronics of the analyzer (“DASTemp”, not directly controlled), and the 
temperature of the analyzer’s wavelength monitor, indicated as 
“WarmBoxTemp.”  

Plot for 
Data Key 3 

Plot for 
Data Key 1  

Source Keys  Data Keys  Precision Auto Scale  

Plot for 
Data Key 2 

Reset Buffers  
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Figure 43: Data Source and Data Key Pull Down Menus 

6.9 Precision Pulldown Menu 
Click on the pull-down to select the precision displayed on the y-axis; between 0 
and 4 digits of precision or auto. The currently selected precision is displayed 
during operation. This does not affect the precision of the saved data in the data 
log files or results files. Auto precision is sufficient for nearly all applications. 

 

Figure 44: Precision Pull-down Pane 

6.10 Analyzer Status Log 
This window displays instrument status messages, in the following form:  
YYYY-MM-DD HH:mm:ss, then ‘Generic message text’. 

Common Status Log Messages 
Following are the most common messages that appear: 

• Pressure Stabilizing/Locked: Displayed when the valve control system 
begins to allow flow through the analyzer and stabilizes the pressure 
inside the cavity. 

• Temperature Locked: WB: When the temperatures of the warmbox have 
stabilized.  

This is typically the longest step in the startup sequence. Startup: 
Depending on ambient temperature, the analyzer and its hotbox 
temperature set point, this step may take as little as 20, or as much as 60 
minutes. Restart: If the instrument is only stopped briefly, this may take a 
few seconds to a few minutes. 
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• Preparing to Measure: Spectral scanning has started. Concentration 
measurements will be available in approximately 30 seconds. The 
instrument will continue to scan and report concentration measurements 
until the instrument is shut down. 

• Measuring: This is the normal mode of operation after startup has 
completed. 

 

Figure 45: Analyzer Status Log 

6.11 Data Buffer Level Meter 
The meter to the right of the Data Window (Figure 46) indicates how much of the 
internal memory of the GUI is used to retain historical data collected with the 
instrument. There is an internal limit of a finite number of points. Once that 
number of data points is collected, the buffer is full, and old data is removed from 
the buffer as new data is collected. This buffer affects only the data displayed in 
the data window, not the data stored in any files. This buffer is empty upon 
instrument startup and can also be emptied by pressing the Reset buffers button 
in the lower-right-hand corner of the GUI. 

  

Figure 46: Data Buffer Level Meter and Reset Buffers Button 

Data Buffer 
Level Meter  

Reset Buffers 

Current Data Buffer Level 
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6.12 Reset Buffers Button 
Click the Reset Buffers button to clear the internal data buffer of the GUI (this 
clears the current data traces from the graphs). This has the effect of clearing all 
data in the data window. Pressing this button has no effect on any of the data log 
files stored by the instrument. 

6.13 Graph Zooming and Panning 
Zooming In/Out 
To zoom in on a specific region of the graph, move the cursor to the area of 
interest, click/hold the left mouse button, then drag as desired to create a box 
that covers the region of interest (see Figure 47). When the box is drawn, release 
the left button and the boxed area will automatically scale to fill the data window.  

 

Figure 47: Data Graph Zoom Function 

To zoom back out to see all data in the buffer, double-click the left button 
within the graph display. To zoom out indefinitely, right click. Right clicking 
multiple times zooms out further. To auto scale the y-axis of either graph, use the 
Auto-Scale buttons below the graph as shown in Figure 48. 

To Zoom the X and Y axes: hold down the control button and move the cursor 
up/down or left/right using the right mouse button 

 

Figure 48: Auto-scale Buttons 

Example only. The 
gas species on your 
analyzer may differ. 
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Lock/Unlock Time Axis 
Zoom and pan features are often useful when time axes are locked, and the user 
wishes to align the Y axis in multiple plots. To lock or unlock the time axis of each 
graph during zooming, from the View menu, select Lock time axis when 
zoomed or Unlock time axis. 

Panning 
To pan the data in the X or Y axis: hold down the control button and drag the 
cursor using the left mouse button. 
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7. User Management 

7.1 Overview 
User management includes: 

• Managing user accounts, such as adding users and changing passwords. 

• Setting user policies, such as password requirements and session 
duration. 

• Viewing and saving user histories. 

There are three user roles defined in the system: operator, technician, and 
administrator. The permissions are as follows: 

Table 5: User Accounts/Functions 

Function 

N
ot

 S
ig

ne
d 

In
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pe

ra
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r 

Te
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Ad
m

in
is

tra
to
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View Data Viewer x x x x 

Set Alarms   x x x 

Configure Data Viewer (partial)   x x x 

Quit Measuring  x x x 

Quit (software shutdown)  x x x 

Configure Data Viewer (full access)    x 

User Management    x 

User management settings are available from the Tools menu in the Data Viewer 
or by using the Picarro Launch Pad. Use one of the following procedures. 

From the Data Viewer: 

1. From the Users menu, select User Login. 

2. Login as an administrator (default user name is admin; default password 
is admin). 

3. From the Tools menu, select User Administration to view the User 
Management a shown in Figure 49. 
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From Picarro Launch Pad: 

1. Select the Config and Users button. 

2. From the User Management Tool login as an administrator (default 
user name is admin; default password is admin). 

3. The User Management window displays with the following tabs:  
User Accounts, User Policies, and User History. 

 

Figure 49: User Management/User Accounts Tab 

7.2 Managing User Accounts 
The following features are available from the User Accounts tab and are further 
described in this section: 

• Change user passwords 

• Change user roles 

• Disable users 

• Add new users 
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NOTE 

The default user names that are provided with the analyzer are tech, operator, 
and admin. The default passwords are tech, operator, and admin, respectively. 
User names and passwords are both case sensitive. 

Changing a User Password 
1. In the User Management window, click the User Accounts tab. 

From the list of users, click the user you want to change and select the 
Change Pwd button. The user account information displays. 

 

Figure 50: Change Password 

3. In the New Password field, enter the new password. 

Passwords are case sensitive. Additional rules for passwords can be set 
in the User Policies tab. For more information, see 7.3 Setting User 
Policies. 

4. In the Confirm Password field, re-enter the password. 
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5. Click Next to save the password 

Changing a User’s Role 
1. In the User Management window, click the User Accounts tab. 

2. From the list of users, click the user you want to change. 

3. From the Change Role drop-down, select the new role and click Ok 
when prompted. 

The role is now changed to the desired setting. 

 

Figure 51: Change Roles 

Disabling a User Account 
Users cannot be deleted from the system, but they can be disabled to prevent 
access to the software. See Figure 52 for more information. 

1. In the User Management window, click the User Accounts tab. 

2. From the list of users, click a user name.  

3. Click Disable User; this will prompt you to confirm your choice. 

4. Click OK to confirm the action. 
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Figure 52: Disable Users 

Adding a User 
1. In the User Management window, click the User Accounts tab. 

2. Click Add User; this will display the Add User screen. 

 

Figure 53: Add User 
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3. Fill in the fields in the Add User window. 

4. Click Next to open the New User Account dialog. 

5. Review the user information and click OK to accept or Cancel to go 
back and edit the information. 

7.3 Setting User Policies 
1. In the User Management window, click the User Policies tab. 

2. Make any changes. For more information, see the following section 
User Policy Descriptions. 

3. Click Save. If you typed an incorrect value and want to undo any 
changes and revert back to the last saved configuration, click Revert. 

 

Figure 54: User Policies Tab 
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User Policy Descriptions 
The following table provides descriptions for the various user policies. 

Table 6: User Policies 

Policy Description 

Password length Specify that the length of passwords (6–15 characters) or 
turn off the length requirement. 

Password complexity When selected, all new passwords must have at least one 
number, one letter, and one special character. This will not 
impact existing passwords. 

Password expiration When selected, any passwords that reach the selected 
maturity will expire. Any user signing in with an expired 
password will be required to create a new password. 

Previous passwords  When set, prevents a user from reusing a recent password. 
The system can remember up to 10 old passwords. 

Limit login attempts Tell the system to disable a user account after a set 
number of failed password attempts. The failed attempts 
are counted until the user successfully logs in. Once 
disabled, an admin will have to enable the account. 

Lock session When set, the system will automatically logoff any user 
after a set period of inactivity, requiring the user to sign in 
again. 

Change password Allows the user to change their own password. 

Change phone 
number 

Allows the user to change phone number and restrictions. 

Change email Allows user to change their email address. 

Change name Allows the user to change first and last name. 

Save user actions When enabled, user actions (such as logging in) will be 
saved in the User History. 
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7.4 Viewing User History 
1. In the User Management window, click the User History tab to see a list 

of all the logged events. 

 

Figure 55: User History Tab 

2. Click the < and > buttons to navigate through the history (if the button is 
grayed out, then there are no additional pages). 

3. To make sure the content is up to date, click Refresh. 

4. To copy the user history onto a USB drive, click Download. This 
laucnhes the File Manager, which will prompt to login. See File Manager 
on page 45 for details on copying files from the analyzer. 
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8. File Management 
The Picarro Analyzer generates ASCII-format text output files that are updated after 
each batch of concentration measurements is complete. The data files are stored 
primarily in DataLogger folders and are also mirrored in folders which retain more 
situational data. Some analyzers also produce discrete measurements stored in 
separate isotope data folders. All user data is archived, compressed, and retained, either 
shortly after the measurements or at a later point, to optimize space on the hard drive. 

8.1 Data Archive  
The archive directory is: 

/Home/Picarro/I2000/Log/Archive 

This archive stores daily measurement and RDF data. Each folder is designated 
by date (YYYY-MM-DD) and has subdirectories: 

DataLog_Private, DataLog_User, EventLogs, and WBCAL. 

The Data Log files are in a simple text format (white-space delimited) with a DAT 
file extension. By default, each file stores one hour of data. 

Certain instruments may contain additional sub-folders under: /Home/UserData 
relating to time synced file formats, soil flux, or GPS data, among others. If the 
user has any questions about this file structure, they can contact Picarro Support. 

There are complete data files which include additional information beyond the 
concentration data including parameters such as instrument temperatures and 
pressure, set points and spectroscopic information. This information is generally 
not useful to the user, but can be useful for diagnostic purposes and is stored in 
the following directory: 

home/picarro/I2000/Log/Archive/yyyy-mm-dd/DataLog_Private 

The archive files are in a HDF5 format, a more efficient data storing format with an 
.h5 file extension. 
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8.2 Data File Name 
The file name is generated from the analyzer serial number, the date, and the 
time when the file was started. The specific time stamp will depend upon the time 
the instrument was started and began measuring sample gas, so files seldom 
begin exactly at the top of the hour. For example: 

 

Figure 56: Example Data File Name 

• JKBDS5200 is the analyzer serial number 

• 20231130 is the date, in format yyyymmdd (to allow chronological sorting 
of data files). 

• 005153 is the time the file was started in the computer’s local time 
00:51:53, formatted as hhmmss using a 24-hour clock. Note that the time 
stamp of samples within the file is usually recorded in UTC (GMT) relative 
to the local time. For example, an analyzer in California will usually have a 
time stamp (UTC) within the file that is 8 hours ahead of the time stamp in 
the file name itself (UTC - 8).  

8.3 File Archiving 
Picarro instruments will not delete data. Some instruments will, however, 
compress and archive older data to conserve hard drive space. Raw data file 
archiving frequency and details can be modified in the file:  

Home/Picarro/I2000/AppConfig/Config/Archiver/Archiver.ini. 

 
CAUTION 

To avoid losing data, discuss with Picarro support before attempting any 
changes to the Archiver.ini file. 

Instrument Serial 
Number 

Date Time (Local) 

JKBDS5200-20231130-005153Z-DataLog_User.dat 



File Management   

PI5310 UM P/N 40-0103 Rev. A 73 

For each file type, there are various items along with some recommended default 
settings which may vary by file type: 

• Directory = /Home/Picarro/I2000/Log/Archive 

Optionally specifies which directory to find files to archive. 

• MaxCount = -1 

Specifies how many files to keep. A setting of -1 indicates that there is no 
maximum number of files. Generally, -1 is used in conjunction with a 
maximum size limit, below. 

• MaxSize_MB = 1500 

Specifies that a maximum of 1.5 GB of data is to be kept before the 
system begins to archive old data. 

• Compress = True/False 

Specifies if archived files are to be zipped – recommended setting is true 
to save hard drive space. True means files are zipped, false means files 
are not zipped. 

• AggregationCount = 0 

If compression is set to TRUE, specifies how many files to be included in 
each zip archive. 

• StorageMode = FIFO 

First in first out. Specifies that old data is archived first. 

• Quantum = 4 

Generally, should not be changed. Specifies the files to be sorted by 
year\month\day\hour in the archived directory structure. 
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9. Modbus Communication 
Modbus is a client/server data communication protocol to support communication to and 
from multiple devices connected to the same cable. Modbus can be configured for 
TCP/IP on port 50500 or RTU utilizing the analyzer’s COM1 port. See the following 
section on how to configure Modbus communication.  

9.1 Configuring Modbus Communication 
1. From the Picarro Launch Pad, select Config followed by the Modbus 

button to configure the Modbus server as shown in Figure 57. 

 
NOTE 

Note the Config menu requires login to access the configuration menu. Log in 
with a user name and password. 

 

 

Figure 57: Settings/Modbus Configuration 
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This displays the Modbus Settings window shown in Figure 58.  

 

Figure 58: Modbus Settings Window 

From the Modbus Settings window the following configuration options are 
available: 

• Slave ID – The analyzer’s Slave ID. 

• Modbus Type – Modbus Communication Protocol: TCP/IP or RTU. For 
more information, see section 9.2 Modbus Data Registers Overview and 
Setup. 

TCP Port – Designates the TCP port if TCP/IP is selected. 

Additionally, the window displays the CommandInterface Status. However, if 
Modbus Type is set to RTU, then the CommandInterface on COM 1 is disabled. 
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9.2 Modbus Data Registers Overview and Setup 
This section describes the basic types of MODBUS data registers and setup 
information.  

Table 7: MODBUS Register Types 

Name Size Access 

Input Register 16 bits Read-only 

Holding Register 16 bits Read-write 

Discrete Input 1 bit Read-only 

Coils 1 bit Read-write 

 

Setup Notes for Modbus TCP 
• MODBUS is configured for TCP/IP on port 50500. 

• When MODBUS is configured on port 50500, communication is also 
possible via port 502. 

• If MODBUS is configured as TCP/IP and the IP address of analyzer is 
changed, the user needs to restart the host application to run MODBUS 
with the updated IP address.  

• MODBUS over TCP/IP does not support privileged ports (0 to 1023), 
except for port 502. 

Setup Notes for Modbus RTU 
• MODBUS RTU uses the analyzer’s COM1 port. 

• To establish connection between master and slave over MODBUS RTU, 
user needs to establish connection using "Straight Through Cable”.  

• When MODBUS is configured for RTU, CommandInterface on COM1 will 
be disabled.  

9.3 Modbus Register Maps Overview 
• Data returned is in big endian format if it utilizes more than one Modbus 

register.  

• If input register functionality is not available for a given analyzer type, the 
instrument will return value as “NaN” for float values and “False” for 1-bit 
registers. 
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• Memory map is continuous memory. If a user tries to read a register 
address for which functionality is not available, it will return “0”. For 
example, reading address “0” for coil registers returns “0” since the 
address does not exist. 

• If a user tries to read a register address outside of maximum register 
memory map, the request will return an exception. For example, reading 
address 156 for coil register will return exception code “0x02” (Illegal 
address).  

• System time is in milliseconds since 0001-01-01 AD. 

9.4 Input Register Map 
Most of the readings in Picarro analyzer are the float type and need 32-bit data. 
Each parameter utilizes two registers, out of which the first one will be storing 
MSB and the second one will be storing the LSB of the float number. 

Table 8: Input Registers 

Address Description Units Type Comments 

1-6 Time stamp  Unitless String 
Long value return as 12byte 
string. Date will be in format 
YYMMDDHHMMSS 

7-8 N2O Concentration  ppb Float  

9-10 N2O_ID ppb Integer 8 for N2O 

11-12 N2O_30sec ppb Float  

13-14 N2O_2min ppb Float  

15-16 N2O_5min ppb Float  

17-18 N2O_Maximum ppb Float  

19-20 N2O_Minimum ppb Float  

21-22 CO Concentration ppb Float  

23-24 CO_ID ppb Integer 5 for CO 

25-26 CO_30sec ppb Float  

27-28 CO_2min ppb Float 
 

29-30 CO_5min ppb Float  

31-32 CO_Maximum ppb Float  

33-34 CO_Minimum ppb Float  
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Address Description Units Type Comments 

35-36 H2O Concentration ppm Float  

37-38 H2O_ID ppm Integer 0 for H2O 

39-40 H2O_30sec ppm Float  

41-42 H2O_2min ppm Float  

43-44 H2O_5min ppm Float  

45-46 H2O_Maximum ppm Float  

47-48 H2O_Minimum ppm Float  

49-200 Reserved 

201-202 CavityPressure Torr Float  

203-204 CavityTemp oC Float  

205-206 DasTemp oC Float  

207-208 EtalonTemp oC Float NaN 

209-210 WarmBoxTemp oC Float NaN 

211-212 OutletValve Unitless Integer  

213-214 Gas1_instrCal_slope Unitless Float NaN 

215-216 Gas1_instrCal_offset Unitless Float NaN 

217-218 Gas1_userCal_slope Unitless Float NaN 

219-220 Gas1_userCal_offset Unitless Float NaN 

221-222 Gas2_instrCal_slope Unitless Float NaN 

223-224 Gas2_instrCal_offset Unitless Float NaN 

225-226 Gas2_userCal_slope Unitless Float NaN 

227-228 Gas2_userCal_offset Unitless Float NaN 

229-230 Gas3_instrCal_slope Unitless Float NaN 

231-232 Gas3_instrCal_offset Unitless Float NaN 

233-234 Gas3_userCal_slope Unitless Float NaN 

235-236 Gas3_userCal_offset Unitless Float NaN 

237-238 Gas4_instrCal_slope Unitless Float NaN 

239-240 Gas4_instrCal_offset Unitless Float NaN 

241-242 Gas4_userCal_slope Unitless Float NaN 

243-244 Gas4_userCal_offset Unitless Float NaN 
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Address Description Units Type Comments 

245-300 Reserved 

301-302 Etalon1 Unitless Float NaN 

303-304 Etalon2 Unitless Float NaN 

305-306 Ratio1 Unitless Float NaN 

307-308 Ratio2 Unitless Float NaN 

309-310 Reference1 Unitless Float NaN 

311-312 Reference2 Unitless Float NaN 

313-386 Reserved 

387-388 Errors Integer Float  

389-390 Measurement_Status Integer Float  

9.5 Discrete Input Register Map 
The following table describes the discrete input registers. Please note the 
following: 

• All data unit are unitless unless otherwise noted.  

• All data types are floats unless otherwise noted. 

• All unused addresses are reserved.  

Table 9: Discrete Input Registers 

Address Description 

1 MasterSystemStatus 

2-5 Reserved 

6 CavityPressureStatus 

7 CavityTempStatus 

8 WarmBoxTempStatus 

9-72 Reserved 

73 Incomplete_GAS1_spectrum 

74 Incomplete_GAS2_spectrum 

75 Incomplete_GAS3_spectrum 

76 Incomplete_GAS4_spectrum 
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Address Description 

77 Incomplete_GAS5_spectrum 

78 Incomplete_GAS6_spectrum 

79 Incomplete_GAS7_spectrum 

80 Incomplete_GAS8_spectrum 

81 GAS1_baseline 

82 GAS2_baseline 

83 GAS3_baseline 

84 GAS4_baseline 

85 GAS5_baseline 

86 GAS6_baseline 

87 GAS7_baseline 

88 GAS8_baseline 

89 GAS1_performance 

90 GAS2_performance 

91 GAS3_performance 

92 GAS4_performance 

93 GAS5_performance 

94 GAS6_performance 

95 GAS7_performance 

96 Reserved 

9.6 Holding Register Map  
The following table describes the holding registers.  

Table 10: Holding Registers 

Address Description Type Comments 

1-4 SystemTime Integer 
Integer representing milliseconds 
from 1AD January 1st to now 

5-8 UserName  String  

9-12 Password  String  
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Address Description Type Comments 

13-200 Reserved 

201-202 User data 1 Float  

203-204 User data 2 Float  

205-206 User data 3 Float  

207-208 User data 4 Float  

209-210 User data 5 Float  

211-212 User data 6 Float  

213-214 User data 7 Float  

215-216 User data 8 Float  

217-218 User data 9 Float  

219-220 User data 10 Float  

221-222 User data 11 Float  

223-224 User data 12 Float  

225-226 User data 13 Float  

227-228 User data 14 Float  

229-230 User data 15 Float  

231-232 User data 16 Float  

233-234 User data 17 Float  

235-236 User data 18 Float  

237-238 User data 19 Float  

239-240 User data 20 Float  

9.7 Coil Register Map 
Table 11: Coil Register Map 

Address Description Type Function 

1 EnergizeSolenoidValve1 Float get_system_time 

2-115 Reserved Float  

116 ShutDownHost Float MODBUS_ParkInstrument 

117 ShutDownInstrument Float MODBUS_ShutdownInstrument 
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Address Description Type Function 

118-150 Reserved 

151 GetTime Float get_system_time 

152-154 Reserved 

155 SetPassword Float Change_UserPassword 

156 Logout Float MODBUS_UserLogoff 

157-200 Reserved 

201 GetUserData_1 Float GetUserData_1 

202 SetUserData_1 Float SetUserData_1 

203 GetUserData_2 Float GetUserData_2 

204 SetUserData_2 Float SetUserData_2 

205 GetUserData_3 Float GetUserData_3 

206 SetUserData_3 Float SetUserData_3 

207 GetUserData_4 Float GetUserData_4 

208 SetUserData_4 Float SetUserData_4 

209 GetUserData_5 Float GetUserData_5 

210 SetUserData_5 Float SetUserData_5 

211 GetUserData_6 Float GetUserData_6 

212 SetUserData_6 Float SetUserData_6 

213 GetUserData_7 Float GetUserData_7 

214 SetUserData_7 Float SetUserData_7 

215 GetUserData_8 Float GetUserData_8 

216 SetUserData_8 Float SetUserData_8 

217 GetUserData_9 Float GetUserData_9 

218 SetUserData_9 Float SetUserData_9 

219 GetUserData_10 Float GetUserData_10 

220 SetUserData_10 Float SetUserData_10 

221 GetUserData_11 Float GetUserData_11 

222 SetUserData_11 Float SetUserData_11 

223 GetUserData_12 Float GetUserData_12 

224 SetUserData_12 Float SetUserData_12 
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Address Description Type Function 

225 GetUserData_13 Float GetUserData_13 

227 GetUserData_14 Float GetUserData_14 

228 SetUserData_14 Float SetUserData_14 

229 GetUserData_15 Float GetUserData_15 

230 SetUserData_15 Float SetUserData_15 

231 GetUserData_16 Float GetUserData_16 

232 SetUserData_16 Float SetUserData_16 

233 GetUserData_17 Float GetUserData_17 

234 SetUserData_17 Float SetUserData_17 

235 GetUserData_18 Float GetUserData_18 

236 SetUserData_18 Float SetUserData_18 

237 GetUserData_19 Float GetUserData_19 

238 SetUserData_19 Float SetUserData_19 

239 GetUserData_20 Float GetUserData_20 

240 SetUserData_20 Float SetUserData_20 
 

 
NOTE 

• Data is in big-endian format if it utilizes more than one Modbus register. 
• If input register functionality is not available for analyzer type, analyzer 

will return value as NaN for float values. 
• Memory map is continuous memory, so if user try to read address for 

which functionality is not available it will return “0” (for example reading 
address “0” for coil register). 

• If user tries to read address outside of maximum register memory map, 
request will be exception (for example reading address 156 for coil 
register). 
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10. Serial Communication 
The Serial Port Menu is accessible from the Config Menu and displays the 
configurations of COM1 (used for Command Interface, query-based data output) 
and COM2 (used for Data Streaming). Users need to set the COM port protocol 
by using the Serial Port Configuration feature located from the Picarro Launch 
Pad, Config, and selecting the Serial Port button. 

 

Figure 59: Default Serial Port Configuration 

The Serial Port Configuration windows provides the following settings: 

• Port – Indicates the desired communication port. 

• Baud Rate – Number of bit transfers per second. 

• Data Bits – Number of data bits in a communication packet, or a single 
byte transfer. 

• Stop Bits – Number of bits used to signal the end of a communication 
packet. 

• Parity – Sets the parity bit to Even, Odd, Mark, Space, or None. 

• Enable Serial Port – Enables or disables the communication port 
specified in the Port field. 

After making any changes, select Save to apply the changes or Undo to revert to 
the previous configuration. Click OK to close the window. 
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10.1 COM1 (Command Interface) Protocol 
The Command Interface defines query-based data communication through 
COM1. The default data list and serial port setting for the PI5310 are: 

/home/picarro/I2000/AppConfig/Config/CommandInterface/ 
CommandInterface_JKBDS.ini 

meas_label = 
N2O,N2O_dry,CO,CO_dry,H2O,c13o2,interval,ValveMask,OutletValve,Sp
ectrumID,DasTemp,CavityPressure,CavityTemp,BoxPressure 

[SERIALINTERFACE] 
port = /dev/ttyS0 #COM1 
baudrate = 19200 
bytesize = 8 
parity = 'N' 
stopbits = 1 
timeout = 1 
xonxoff = 0 
rtscts = 0 

 

Output Frequency: Data is output when command is sent to COM1 via RS232. 

Example data output: _MEAS_GETCONC and _MEAS_GETCONCEX 

 

Figure 60: Data Output Example 
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10.2 COM2 (Data Manager) Data Streaming Protocol 
The Data Manager defines the data streaming through the serial port, normally as 
COM2. Once enabled, the listed data is streamed through the designated COM 
port. 

/home/picarro/I2000/AppConfig/Config/DataManager/DataManager_JKBDS.i
ni 

[SerialOutput] 
#PollChar = "x" 
Enable = True            # Disable when this COM2 is used for other control. 
Port = /dev/ttyS1 #COM2 
Baud = 19200 
DataBits = 8 
StopBits = 1 
Parity = N 
… 

The default list for PI5310 is as follows. Users may edit the list for desired output. 

Format ="%15.2f %10.4f %10.4f %10.4f %10.4f %10.4f %10.4f %10.4f %10.4f 
%10.4f %10.4f\r\n" 
time/N2O/CO/H2O/c13o2/interval/CavityPressure/CavityTemp/BoxPressure/DasT
emp/ValveMask 

 

Output Frequency: 

About 2 seconds. 

Example of data streaming output: * COM3 is the computer’s com port. 

 

Figure 61: Data Streaming Output 
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11. Troubleshooting 
The following section lists problems that may be encountered during installation and 
operation of the analyzer. The corresponding step-by-step procedures provide resolution 
in most cases. If, after attempting these procedures, the problem remains unresolved, 
please contact Picarro Customer Service at (408) 962-3990 or support@picarro.com. 

11.1 Power LED on Analyzer Does Not Illuminate 
Context: Turning on the analyzer by momentarily depressing its front panel power 
switch should apply power. The green power LED is illuminated when it detects 
the correct power levels. 

1. Check that the AC power cord is attached and plugged into a working 
outlet. 

2. Check that the rear on-off switch near the AC power cord is in the ON 
position ( I ). 

3. Press and hold the front panel power switch for at least 5 seconds as 
the analyzer may take several seconds to respond. 

11.2 Sample Pressure not Controlled to Appropriate 
Value for Concentration Measurements 
Context: Under normal operation, the cavity pressure is automatically locked to 
the correct value by means of electronically controlled inlet and outlet valves. The 
message “Pressure Locked” on the front panel display and the user interface 
indicates that the cavity pressure is at the appropriate value. Should either of the 
messages “Pressure high” or “Pressure low” be displayed, the cavity pressure is 
out of its correct operating range.  

1. The “Pressure low” message indicates that there is insufficient gas 
available at the inlet of the analyzer. Check the inlet plumbing to the 
analyzer and ensure that the pressure at the inlet is within the 
specifications. Check for blockages in the lines, or regulators that are 
turned off, especially by removing all items upstream of the inlet to see if 
the pressure returns to the spec. If removing plumbing from upstream of 
the instrument inlet doesn’t work, the inlet particulate filter may need to 
be replaced. See section 12, Maintenance for more information. 

2. The “Pressure high” message indicates that gas cannot be removed 
from the analyzer at a sufficient rate. Check the vacuum line between 
the analyzer and the power vacuum unit for leaks. Failure of the vacuum 
pump, injecting dilution gas at excessive pressure, or excessive 
pressure at the inlet can also cause this problem. 

mailto:support@picarro.com
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12. Maintenance 
The advanced, rugged design of Picarro Analyzers provides stable, long-term operation 
with minimal service or maintenance. Except for the following items, the analyzer and 
pump are not user serviceable. Should either appear to malfunction, please refer to the 
Troubleshooting Guide or contact Picarro Support (support@picarro.com).  

As described below, users may obtain preventive maintenance components as part of a 
service plan, as part of a designated PM kit, or individually from the Picarro store.  

12.1 Service Plans 
In addition to basic telephone and email support and remote diagnostics, service 
plans include additional warranty, factory repairs, and parts. Plans are available 
for purchase by contacting sales@picarro.com. The following service plans are 
available for the PI5310 and G5000 analyzers: 

• W3105 Premium Service Plan: Extended warranty; free factory repair; 
free field replaceable parts. See data sheet for complete terms and 
conditions. 

12.2 Particulate Filter Replacement 
There are two user-replaceable filters in the PI5310 analyzer. One is located 
behind the Sample inlet, and another is located behind the Pressure inlet. Both 
are accessible from the back panel by releasing the captive screws and sliding the 
filter out of its bay within the analyzer. This section describes filter replacement for 
the Sample and Pressure inlets. Replacement filter kits can be purchased from 
Picarro. 

 
NOTE 

Gasses at the Sample inlet is filtered by two in-line, sub-micron particulate filters 
before they reach the measurement cavity. The inner filter is NOT user 
replaceable. It is located within a heated pressure-box. If the inner filter fails, 
contact Picarro for service or repair. 

The outer filter (located just behind the Sample inlet) is user-replaceable.  

 

  
CAUTION 

The inner filter (in the sample path) is NOT user replaceable. Do NOT open the 
analyzer. Inner filters must be replaced by a Picarro certified technician. USER 
REPLACEMENT OF THE INNER FILTER OR BREAKING THE ANTI-TAMPER TAPE 
ON THE INNER FILTER VOIDS THE WARRANTY. 

mailto:support@picarro.com
mailto:sales@picarro.com
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Symptoms of a Clogged Filter 
Filters can become clogged with continual use. 

If liquid water is sucked into the inlet line, it may clog the filter and impede the flow 
(usually for a few days) until it evaporates. 

Some symptoms of a clogged filter are: 

• The analyzer pressure is low 

• Low flow into the analyzer, causing unusual measurements 

• Response time is slower than usual 

Solutions for Water Incursion 
Do NOT turn off the analyzer when a filter is wet or replace a wet filter. Liquid 
water in the filter can cause condensation on the optics if the analyzer is allowed 
to cool when the filter is wet. 

• Dry the filter by running Clean Dry Air (CDA) through the analyzer. If the 
analyzer functions normally after drying, a filter replacement is not 
necessary. 

• If drying the filter does not solve the problem, replace the filter. 

Required Parts and Tools 
• S3266 PI/SI5000 User Maintenance Kit 

• 9/16 open end wrench 

• Flathead screwdriver for releasing captive screws (if needed). 

Pressure Inlet Port Particulate Filter Replacement 
1. Shut down the analyzer by following Section 5.2, Shutdown, and move 

the analyzer to a clean work environment. 

2. Release the captive screws (Figure 62) and slide the filter assembly out 
of the analyzer filter bay. There may be some resistance as the filter is 
removed. This is due to the frictional resistance of the male quick-
disconnect O-rings within the female receptacle. 
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Figure 62: Pressure Inlet Port 

3. Figure 63 shows the pressure inlet port filter assembly after removal. It 
is not necessary to remove the hose from the barbed inlet port. 

 

Figure 63: Pressure Inlet Filter Assembly – Removed from Housing 

4. Remove the old filter from the bulkhead assembly by loosening the 
compression nut (Figure 64). Remove the ferrules and discard. 

Captive Screws  

Male Quick-disconnect  
Compression Nut  

Captive Screw 
(2 ea.)  

Barbed pressure 
Inlet Port  

Pressure Inlet  

Removable 
Inlet Bulkhead 

Removing Filter  
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Figure 64: Removing Filter from Pressure Inlet Bulkhead 

5. Remove the male quick-disconnect from the filter outlet by loosening 
the compression nut (Figure 65). Remove the ferrules and discard. 

 
 

Figure 65: Filter Removed from Pressure Inlet Bulkhead 

6. Install the new ferrules onto the bulkhead compression fitting. 

7. Attach a new filter to the bulkhead compression fitting. 

Ensure the flow direction arrow on the filter is pointing away from the 
bulkhead compression fitting. Also ensure the tube and ferrules are fully 
seated into the filter fitting before fully tightening the nut. 

8. Tighten the nut on the fitting until the final bit of thread is just showing 
past the nut (Figure 66). 

Compression 
Nut  Quick-disconnect 

Removed 

Gas Flow 
Direction  
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Figure 66: Tightening the Filter Fittings 

9. Install the new ferrules onto the quick disconnect fitting. 

10. Reinstall the male quick disconnect to the new filter. Ensure the tube 
and ferrules are fully seated into the filter fitting before fully tightening 
the nut. 

11. Tighten the nut on the fitting until the final bit of thread is just showing 
past the nut (Figure 66). 

12. Slide the completed assembly into the analyzer filter bay and secure 
the plate by tightening the captive screws.  

Note that when the filter assembly is about half an inch from the analyzer 
chassis, you will meet resistance as the male quick-disconnect enters its 
receptacle. You will need to firmly push it inward to fully seat the 
assembly. Then the captive screws can be tightened. 

Sample Inlet Port Particulate Filter Replacement 
1. Release the captive screws (Figure 67) and slide the filter assembly out 

of the analyzer filter bay. There may be some resistance as the filter is 
removed. This is due to the frictional resistance of the male quick-
disconnect O-rings within the female receptacle. 

  

Figure 67: Sample Inlet Port 

Captive Screw 

Captive Screw  

Sample Inlet  

Removable 
Inlet Bulkhead 

Tighten until the final 
thread is just showing. 

Removing Filter  
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2. Figure 68 shows the sample inlet filter assembly after removal. It is not 
necessary to remove the hose from the sample inlet port. 

 

Figure 68: Sample Filter Assembly – Removed from Housing 

3. Remove the old filter from the bulkhead assembly by loosening the 
compression nut (Figure 69). Remove the ferrules and discard. 

4. Remove the male quick-disconnect from the filter outlet by loosening 
the compression nut (Figure 70). Remove the ferrules and discard. 

 

Figure 69: Removing Filter from Sample Inlet Bulkhead 

  

Figure 70: Filter Removed from Sample Inlet Bulkhead 

5. Install the new ferrules onto the bulkhead compression fitting. 

6. Attach a new filter to the bulkhead compression fitting. 

Male Quick-disconnect  

Compression Nut  

Captive Screw 
(2 ea.) 

Sample Inlet Port  

Compression 
Nut  

Quick-disconnect 
Removed 

Gas Flow 
Direction  
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Ensure the flow direction arrow on the filter is pointing away from the 
bulkhead compression fitting. Also ensure the tube and ferrules are fully 
seated into the filter fitting before fully tightening the nut. 

7. Tighten the nut on the fitting until the final bit of thread is just showing 
past the nut (Figure 66 above). 

8. Install the new ferrules onto the quick disconnect fitting. 

9. Reinstall the male quick disconnect to the new filter. Ensure the tube 
and ferrules are fully seated into the filter fitting before fully tightening 
the nut. 

10. Tighten the nut on the fitting until the final bit of thread is just showing 
past the nut (Figure 66). 

11. Slide the completed assembly into the analyzer filter bay and secure 
the plate by tightening the captive screws.  

o Note that when the filter assembly is about half an inch from the 
analyzer chassis, you will meet resistance as the male quick-
disconnect enters its receptacle. You will need to firmly push it inward 
to fully seat the assembly. Then the captive screws can be tightened. 

A2000 Pump Rebuild Kit 
The pump rebuild kit is the only component not currently sold as part of a 
preventive maintenance kit because the replacement frequency is not strictly 
annual (frequency depends on pump usage).  

The A2000 pump diaphragms and valves are user-replaceable. Use the following 
link to order rebuild kits and to find the instructional video and supporting 
maintenance document. 

• Pump Rebuild Kit: Used with SI2xxx, G2xxx analyzers (except Flight and 
Flux analyzers) 

S2009 Rebuild Kit for A2000 Vacuum Pump – If viewing this manual as 
a paper hard copy, enter the following URL in your browser: 

http://store.picarro.com/For-Analyzer/Pump/Rebuild-kit-for-Picarro-A2000-
vacuum-pump.html 

12.3 Cleaning and Decontamination 
Clean the outside of the analyzer with a clean dry cloth. Users should never 
access or clean the inside of a Picarro analyzer. For decontamination, run clean 
dry air (CDA) through the analyzer. If the analyzer does not decontaminate after 
running CDA for several hours, contact Picarro. 

http://store.picarro.com/For-Analyzer/Pump/Rebuild-kit-for-Picarro-A2000-vacuum-pump.html
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13. Transportation and Storage 
If the analyzer is transported or stored, use the following procedure to prepare and 
repack it into the original packaging. 

 
CAUTION 

When shipping or relocating the analyzer, it is important to protect it from 
mechanical shocks. Failure to do so can compromise its performance. When 
shipping the analyzer, use its original packaging only. 

13.1 Shutdown and Preparation 

 
CAUTION 

A flow of clean, dry gas should always be directed to the instrument for several 
minutes prior to shutting down. Trapping a high-moisture content gas sample in 
the cavity can cause condensation damage to the mirrors as the instrument 
cools from its operating temperature. See section 5.2, Shutdown for specific 
shutdown instructions for your model analyzer. 

1. Click on the Quit button located on the left bottom side of the Data 
Viewer window. 

2. A window displays (Figure 62) prompting the user to confirm the 
shutdown. Click Yes to continue with the shutdown process. 

 

Figure 71: Stop Data Acquisition/Shutdown 

3. Manually turn off the pumps and dry gas (if used). 

4. Disconnect all tubing and electrical connections from the analyzer. 

5. To prevent contamination and possible damage to the connection 
threads, place protective caps on all gas connections. 

13.2 Packing 
1. Place the analyzer in a plastic bag with a package of desiccant. Seal the 

bags with tape. If shipping the pump, do the same for it. 

2. Pack the analyzer and pump in the original shipping containers ensuring 
that all the foam pieces are in place to protect the analyzer during 
shipping.
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APPENDIX A – Alarm Status 
ALARM_STATUS is a data column output by the instrument to warn the user 
when the instrument measures a gas that could produce data that falls outside of 
the operational range of the instrument. Falling outside of the operational range of 
the analyzer can cause the instrument to perform with a lack of precision, 
accuracy, or data rate. ALARM_STATUS is a flag nominally set to 0 when 
measuring “ordinary” ambient air and can be set to a number corresponding to a 
binary mask of a specific alarm. 

The following table provides the alarm status bit assignments. 

Table 12: Alarm Status Bit Assignment 

Bit 7 6 5 4 3 2 1 

Alarm Cavity 
Pressure 

Cavity 
Temp 

LaserBase 
plateTemp 

Box 
Pressure [H2O] [CO_dry] [N2O] 

Nominal 
100 ± 0.05 

Torr 
40 ± 0.01 
Degree C 

27 # ± 0.1 
Degree C 

800 ± 1 
Torr 

< 22000 
ppb 

< 1500 
ppb 

< 1500 
ppb 

# Some hot operated lasers may be set to higher laser baseplate temperature. 

Each decimal ALARM_STATUS reading converts to binary and uses the above 
table to identify the detailed alarm as single or combination. 

The following table provides several examples. 

Table 13: Alarm Status Definitions 

ALARM_STATUS Binary Mask Alarm Definition 

0 0000000 All alarm cleared; analyzer is in normal operation. 

1 0000001 N2O_dry concentration is over 1500 ppb. 

6 0000110 CO_dry concentration is over 1500 ppb, and H2O 
concentration is over 22000 ppm. 

32 0100000 Cavity Temperature is out of setting range. 

64 1000000 Cavity Pressure is out of setting range. 
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APPENDIX B – Data Log Columns 
Below is a table that describes all columns contained in the data log. The data log 
provides a complete set that has all outputs produced by the analyzer and 
includes the User Logs described above and found in: 

 /home/picarro/I2000/Log/Archive/YYYY-MM-DD/DataLog_User/ 

Table 14: PI5310 Data Log Columns 

Data Key Units Definition 

ALARM_STATUS unitless Alarm status bit mask  
(see APPENDIX B – Data Log Columns) 

ALARM_WORD_0 unitless  

BoxPressure Torr Coolbox pressure reading 

BoxPressureLock unitless Status of coolbox pressure locking in 
range  

CO ppb Raw CO concentration reading in gas 
stream 

CO_dry ppb CO concentration reading (dry) in gas 
stream 

CavityPressure Torr Sample pressure in cavity 

CavityTemp oC Averaged temperature of cavity body 

CavityTemp1 oC Cavity temperature #1 (by front cavity 
mirror) 

CavityTemp2 oC Cavity temperature #2 (between #1, #3) 

CavityTemp3 oC Cavity temperature #3 (between #2, #4) 

CavityTemp4 oC Cavity temperature #4 (by rear cavity 
mirror) 

ChillerTemp oC Coolant temperature in TEC cooler block 

CoolBoxAuxTec unitless Coolbox TEC control signal 

CoolBoxHeatsink1Temp oC Front TEC heatsink temperature in 
coolbox 

CoolBoxTec NA  

DasTemp oC Temperature sensor on DAS – PCBA, ~ 
+6 offset to environmental temperature 
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Data Key Units Definition 

DetectorAdc unitless Baseline ADC signal from detector 

FDC_ALARM NA  

FRAC_DAYS_SINCE_JAN1 days Days since January 1, 1970 

FRAC_HRS_SINCE_JAN1 hours Hours since January 1, 1970 

H2O ppm H2O concentration reading in gas stream 

INST_STATUS unitless Instrument status bit flag 

InletValve unitless Inlet valve current signal for coolbox 
pressure control 

JULIAN_DAYS seconds Time assigned since January 1, 4713 BC 

LED_STATE unitless LED state for front panel 

Laser1Current unitless Laser current signal sent to Laser 

Laser1Tec unitless TEC signal for laser temperature control 

Laser1Temp oC Laser temperature 

LaserBaseplateTec oC NA 

LaserBaseplateTemp unitless NA 

MPVPosition unitless Multi-port valve state selected 

N2O ppb Raw N2O concentration reading in gas 
stream 

N2O_dry ppb Raw N2O concentration reading (dry) in 
gas stream 

OutletValve unitless Outlet valve current signal for cavity 
pressure control 

P_stable unitless Whether cavity pressure is steadily 
controlled 

Pcavity Torr Pressure in measurement cavity 

Pcavitystd Torr Standard deviation of pressure in cavity 
over one measurement 

SpectrumID unitless Number assigned to measurement of 
species. 170 for PI5310. 

ValveMask unitless Binary valve mask of triggered solenoid 
valve 
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Data Key Units Definition 

allLow unitless Binary flag if all gas concentrations are 
low 

base1 ppb/cm Base lose in peak1 (N2O) spectral region. 

base31 ppb/cm Base lose in peak31 (H2O) spectral 
region. 

base40 ppb/cm Base lose in peak40 (13CO2) spectral 
region. 

base50 ppb/cm Base lose in peak50 (CO) spectral region. 

c13o2 ppm Raw 13CO2 concentration reading in gas 
stream 

c13o2_dry ppm 
13CO2 concentration reading in gas stream 
with dry correction 

co_fineLaserCurrent unitless Fine laser current at the peak of CO 
spectral line 

co_fsrIndex ppb Fsr index of CO peak within whole 
acquired spectra 

copts unitless Number of points on CO absorption peak 

cords unitless Number of ring-downs on CO absorption 
peak 

di_rms unitless RMS of fineLaserCurrent to fsrIndex 2nd 
order polynomial fit 

dm_latency seconds Time for data to move through 
Datamanager 

fitBackground ppb/cm Averaged detector background to last raw 
ringdown traces, 4x 

fit_time seconds Duration to fit data to model 

gaps unitless Number of gaps in the spectra within last 
measurement interval 

interval seconds Duration for one-point measurement 

max_cavity Torr Maximal cavity pressure within last 
measurement interval 

max_diff_cavity Torr Maximal cavity pressure difference with 
last measurement 

max_fitter_latency seconds Duration to fit data to model 
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Data Key Units Definition 

min_cavity Torr Minimal cavity pressure difference with 
last measurement 

mode_span unitless Number of modes in fit region 

n2o_fineLaserCurrent unitless Fine laser current at the peak of N2O 
spectral peak 

n2opts unitless Number of points on N2O absorption peak 

n2ords unitless Number of ring-downs on N2O absorption 
peak 

ngroups unitless Number of fsr group modes in fit region 

ntopper unitless Number of points at the CO peak 

numpoints unitless Number of ringdowns in spectra 

peak1 ppb/cm Peak absorption of N2O feature 

peak31 ppb/cm Peak absorption of H2O feature 

peak40 ppb/cm Peak absorption of 13CO2 feature 

peak50 ppb/cm Peak absorption of CO feature 

peak_height ppb/cm Peak height of CO absorption peak 

pzt_adjust unitless PZT adjustment after each measurement 

pzt_mean unitless PZT average value in each measurement 

pzt_offset unitless Effective PZT value with adjustment 

range_shift fsr Spectra offset in FSRs from nominal 
position 

rejected point Number of ringdowns rejected by fsr-
hopping grouping filter 

res_pre unitless Residuals after fitter scheme #0 (pre-fit) 

resa unitless Residuals after fitter scheme #3-5 
(reference for N2O peak fit) 

resb unitless Residuals after fitter scheme #6 
(reference for CO peak fit) 

residuals unitless Residuals after fitter scheme #1 (pre-fit) 

shifta cm-1 Base shift after fitter scheme #3-5 

shiftb cm-1 Base shift after fitter scheme #6 
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Data Key Units Definition 

spect_duration seconds Duration to collect spectrum 

spect_latency seconds Duration to send spectrum 

str1 unitless Raw strength of peak#1 (N2O) without any 
corrections 

str1_dry_TC unitless 

Strength of peak#1 (N2O) with 
temperature, interference, and dry 
corrections. Converts to N2O_dry with its 
scaling factor. 

str1_spec unitless 
Strength of peak#1 (N2O) with 
temperature and interference corrections. 
Converts to N2O with its scaling factor. 

str1_spec_raw unitless Last good “str1_spec” without cavity 
pressure burst 

str31 unitless Raw strength of peak#31 (H2O) without 
correction. 

str31_spec unitless 
Strength of peak#31 (H2O) with 
interference correction. Converts to H2O 
with its scaling factor. 

str31_spec_raw unitless Last good “str31_spec” without cavity 
pressure burst 

str40 unitless Raw strength of peak#40 (13CO2) without 
correction. 

str40_dry_TC unitless 
Strength of peak#40 (13CO2) with 
temperature and dry corrections. Converts 
to c13o2_dry with its scaling factor. 

Str40_spec unitless 
Strength of peak#40 (13CO2) with 
interference correction. Converts to c13o2 
with its scaling factor. 

str40_spec_raw unitless Last good “str40_spec” without cavity 
pressure burst 

str50 unitless Raw strength of peak#50 (CO) without 
any corrections 

str50_dry_TC unitless 

Strength of peak#50 (CO) with 
temperature, interference, and dry 
corrections. Converts to CO_dry with its 
scaling factor. 
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Data Key Units Definition 

str50_spec unitless 
Strength of peak#50 (CO) with 
temperature and interference corrections. 
Converts to CO with its scaling factor. 

str50_spec_raw unitless Last good “str50_spec” without cavity 
pressure burst 

time seconds Current time in EPOCH format 

timestamp milliseconds Current time, (time*1000 + 
62135596800000) 

tipstd ppb/cm Loss standard derivation of peak RD-
group at CO peak#50  

tiptop ppb/cm Loss average of peak RD-group at CO 
peak#50  

y1 cm-1 Linewidth of N2O peak 

y31 cm-1 Linewidth of H2O peak 

y40 cm-1 Linewidth of 13CO2 peak 

y50 cm-1 Linewidth of CO peak 
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APPENDIX C – Enabling/Disabling Data 
Output 

The instrument provides customization on data output. Several data outputs can 
be enabled and disabled. Here is the instruction. 

1. Back up the following .ini file. Users can always use the original one for 
recovering. 

2. Modify the applications section as shown below. Adding “#” in front of 
the highlighted lines disables the application load; removing the “#” 
enables the application. Avoid any random mistyping or errors in this 
file. 

3. Restart the computer to make the changes effective. 

The .ini file resides in the following directory: 

/home/picarro/I2000/AppConfig/Config/Supervisor/supervisorEXE_JKBDS.ini 

[Applications] 
EventManager   = 50000 
Driver   = 50010 
Archiver   = 50060 
RDFreqConverter  = 50015 
SpectrumCollector = 50075 
FsrHoppingController = 50016 
Fitter1   = 50180 
MeasSystem  = 50070 
DataManager  = 50160 
SampleManager  = 50080 
InstMgr   = 50110 
AlarmSystem  = 50100 
ValveSequencer  = 50200 # COM#2 by default, upper port of right-bottom of rear panel 
CommandInterface = 50120 # COM#1 by default, lower port of right-bottom of rear panel 
4to20Server  = 50290 # COM#4 by default, on motherboard 
QuickGui  = # 50220 
DataLogger  = 50090 
#Controller  = 50050 
ModbusServer  = 
BackupSupervisor = 
FileEraserSimplified = 
…… 
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APPENDIX D – Analog Current Signal 
Output 

Four channels of 4-20 mA current analog output are available on the back of the 
analyzer. By default, the settings for the four channels are as follows: 

Table 15: Analog Signal Output Settings 

 Iout0 Iout1 Iout2 Iout3 

Monitoring N2O_dry CO_dry H2O Cavity Pressure 

Units ppb ppb ppm Torr 

Min 0.0 0.0 0.0 0.0 

Max 2000.0 2000.0 50000.0 1000.0 

• N2O – Indicates the N2O concentration reading in parts per billion (ppb) 

• CO – Indicates the CO concentration reading in parts per billion (ppb) 

• H2O – Indicates H2O in ppm 

• CavityPressure – Indicates the cavity pressure in Torr 

 

Figure 72: 4–20 mA Output with Terminal Connector in Place 

Conversion from current readings to measurement value: 

Measurement = Min + [ I(reading, mA) – I0 (4 mA) ] / 16 (mA) * (Max- Min) 

For example, channel#0 reading of 6.735 mA indicates: 

N2O (ppb) = 0 + (6.735-4.0) / 16 * (2000.0-0.0) = 341.875. 

Channel#3 reading of 7.805 mA indicates: 

H2O (ppm) = 0 + (7.805-4.0) / 16 * (500000.0-0.0) = 118,906.3. 
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D.1 Connecting the 4–20mA Signal Output 
1. Using your fingers, pull the 4–20 mA terminal connector straight back 

away from the analyzer (Figure 64). 

2. Use a small flathead screwdriver to loosen the slotted retaining screw 
for each desired terminal. 

3. Insert the stripped end of the wire into the terminal slot and tighten the 
retaining screw. 

 

Figure 73: Removing the Terminal Connector 

4. Repeat for each desired terminal. 

5. Slide the terminal connector back onto the analyzer with the retaining 
screws facing down; there should be a soft click when the connector is 
set into its proper position. 

 

Figure 74: Terminal Connector Retaining Screws 

 
NOTE 

If shielding is desired, connect the drain wire of the shielded cable to the ground 
lug on the back panel. Do not connect the shield to the ground pins of the 4–20 
mA connector. Connect only one end of your shielded cable to the ground lug to 
avoid 99ground loops. 
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APPENDIX E – Data File Viewer 

E.1 Quick Start Guide 
The following sections introduce the user to all possible functionalities of the Data 
File Viewer in detail. This section describes the most common, simple use case. 

The Data File Viewer software allows the user to concatenate multiple one-hour 
files into one larger file, enabling the user to observe trends over several days of 
measurements. 

1. To start, translate the UserData files from DAT to H5. The Batch Convert 
option (B) allows users to select any folder containing instrument data 
from a given day. 

 

Figure 75: Batch Convert DAT to H5 – Navigation 

 

2. In the source folder there are now copies of the original files translated 
into the H5 format.  

3. From File menu select Concatenate H5 Files (C) to combine the H5 
files into a time series. Take care to select exactly the same folder in the 
file viewer window. 

4. In the Select Variables window, click All to move over all variables for 
concatenation.  
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If concatenating large records, the user can instead select only a few 
variables by clicking the variable name on the left dialogue and clicking the 
double arrow button. Confirm by clicking OK. 

   

Figure 76: Selecting Variables for Concatenation 

5. The user will then be asked to confirm the file name for the 
concatenated data. The default location is the parent folder for the 
selected day, and the filename by default describes the time span of the 
measurements within. Successful concatenation is indicated by the 
filename automatically being displayed in the main data file viewer 
window as shown in Figure 68. 
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Figure 77: Concatenated Output .h5 Filename 

 
NOTE 

You can concatenate several days into one larger file, either by following steps 
1-3 for selected folders, or by copying all their DAT files into a new folder and 
performing steps 1-5 just once. 

6. With the file now opened, the user can select how many Time Series to 
display on the screen. 

 

Figure 78: Time Series Selection Options 

7. In the new window that displays, select the variables from the Var Name 
dropdown on the right of each plot. Deselect Autoscale y if the data 
stream has a large amount of variability in the Y-axis. 

Please read the following sections to learn more about features of the 
Data File Viewer. 
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E.2 Data File Viewer Overview 
The Picarro Data File Viewer software is located from the Picarro Launch Pad,  
Home menu. This software allows you to graph and to conduct statistical analysis 
of the raw data. Additional functions include Allan Variance plot and quadratic or 
polynomial fittings. The Picarro Data File Viewer includes two main menus: File 
and New (Figure 70, Figure 71).  

 

Figure 79: Picarro Data File Viewer – File Menu 

E.3 File Menu 
This section describes the functions available from the Data File Viewer File 
menu. 

Open File 
File > Open File: Opens a Picarro data file (HDF5 format) for data analysis and 
visualization. After opening the data file, you can create a new time series plot. 
Refer to section C.4, New – Time Series Plot for more information. 

Load Config 
File > Load Config: Loads a configuration file (.ini format) to restore parameters 
of a workplace. Refer to Save Configuration for more information. 

Unpack Zip File 
File > Unpack Zip File: Use to concatenate all H5 files inside the zip file into a 
single H5 file. Refer to Concatenate H5 Files below for details. 
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Concatenate H5 Files 
File > Concatenate H5 Files: Use to concatenate multiple files and zip archives 
of H5 files into a single H5 file. Navigate to the desired folder or use the Define 
Date Range button to specify a date range of files to concatenate. See next 
section Define Date Range for more information. 

After selecting the path of the data files, Data File Viewer will automatically search 
an H5 file in the specified zip/folder and look for all available variables in the H5 
file. The variables are then listed in the Select Variables window in the left panel 
(as shown in Figure 72), and users can use the >> button to move variables to the 
right panel for concatenation.  

E.4 New Menu 
Use the New menu to create a time series plot up to three frames. 

 

Figure 80: Picarro Data File Viewer – New Menu 
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Note: this screenshot is for example only. The species selections shown on your analyzer 
may vary.  

Figure 81: Select Variables Form 

Define Date Range 
Data File Viewer can search data files within the desired date range and then 
concatenate such files into an H5 file. 

By default, TimeZone is set to your local time zone. However, if data were taken 
elsewhere, select the time zone where data was taken. 
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Select File > Concatenate H5 Files, and click Define Date Range to specify the 
desired date range as shown in Figure 73. 

 

Figure 82: Define Date Range Dialog 

Picarro software saves data in directories that are named by the creation year, 
month, and day as shown in Figure 74. Select Data files are saved in directory 
trees named by date and time option if the target folder has this file structure. This 
allows Data File Viewer to only search folders within the desired date range, 
which can substantially reduce processing time.  

 

Figure 83: File Structure of Data File Viewer 
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NOTE 

To save processing time, Data File Viewer does not open data files, but only 
determines data acquisition time based on the file name. 

 

  
CAUTION 

Do not define a time range for data files whose names have been changed. 

 

  
NOTE 

Data File Viewer does not concatenate data files exactly within the defined time 
range. This is because the time extracted from file name is different from the 
data acquisition time. To not miss data points, Data File Viewer expands the 
specified time range, so the resulting dataset normally has a wider time range 
than the user specification. 

Convert DAT to H5 
Select File > Convert DAT to H5 to convert a file in DAT format to HDF5 format. 
These formats are described below: 

• DAT Format: DAT files accepted by DatViewer store tabular data 
(numbers and text) in plain text. 

o Each line of the file is a data record. Each record consists of one or 
more fields separated by whitespaces. 

o The first line of the data file indicates column names. 

o There must be a field “EPOCH_TIME” to store the acquisition epoch 
time (expressed as seconds since Jan 1, 1970) of the data. Otherwise, 
the first and second fields must be “DATE” and “TIME.” The “DATE” 
field must have the format “mm/dd/yyyy” or “yyyy-mm-dd,” and the 
“TIME” field must have the format “HH:MM:SS(.sss)” where (.sss) is an 
optional fraction of seconds. 

• HDF5 Format: HDF5 is a data model, library, and file format for storing 
and managing data. (See the HDF5 Home Page on the HDF Group 
website https://www.hdfgroup.org for more information.) When converting 
DAT to HDF5 format, Data File Viewer creates a table named “results” to 
the contained data. 

https://www.hdfgroup.org/
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Convert H5 to DAT 
Select File > Convert H5 to DAT to convert a file in a HDF5 format to DAT. 
These formats are described in Convert DAT to H5. 

   
NOTE 

Data File Viewer does not concatenate data files exactly within the defined time 
range. This is because the time extracted from file name is different from the 
data acquisition time. To not miss data points, Data File Viewer expands the 
specified time range.  

Interpolation 
Interpolation describes the method for constructing data points with a range of a 
discrete set of known data points. Select File > Interpolation to perform 
interpolation on a time grid with a constant interval. 

Block Average 
Select File > Block Average to divide a dataset into small blocks based on a 
user-defined block size. The average is calculated for data in each block, and the 
results are saved in a new H5 file. 

  
NOTE 

The specified block size must be greater than the average data interval. 

Because the data interval is normally not a constant (unless interpolation is 
performed), fluctuations in the data interval will affect block averaging if the block 
size is comparable to the average data interval. 
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E.5 New – Time Series Plot 
You can specify to include create time-series plots with one, two, or three frames. 
New plots display in the Time Series Viewer.  

 
Note: this screenshot is for example only. The species shown on your analyzer may vary. 

Figure 84: Time Series Viewer 

The next section describes the options available on the Time Series Viewer menu 
bar. Refer to The Time Series Viewer Canvas or more information on the Time 
Series Viewer UI features and options. 

E.6 Time Series Viewer Menus 
This section describes the Time Series Viewer menu options. 

Time Series Viewer File Menu 
Use the File menu to save a configuration or take a screenshot.  
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Figure 85: Time Series Viewer – File Menu 

Save Configuration 
Click File > Save Configuration to open the Feature Capture form. With this 
form, you can save figure properties, expressions, filters, and other settings to a 
configuration file so that it can be easily loaded in the future.  

 

Figure 86: Time Series Viewer – Feature Capture 

  
CAUTION 

If a feature is not captured, it will be omitted when the configuration file is 
loaded. 

Depending on the features captured, loading a configuration file can have different 
effects. For example: 

• If all features are captured, a saved workplace is reproduced. 

• If a data file is not captured, saved parameters are applied to the data file 
in memory. 

• If an expression is not captured, plots will not be transformed. 

• If X (Y) range is not captured, figures are auto-scaled on the x (y) axis. 

Take Screenshot 
Use File > Take ScreenShot to take a screenshot of the Time Series Viewer and 
save it as a .png to a specified file. 

Time Series Viewer Analysis Menu 
Use the Analysis menu to calculate statistics, generate a histogram, and to plot 
correlations and Allan Standard deviations.  
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Figure 87: Time Series Viewer – Analysis Menu 

Statistics 
Use Analysis > Statistics to calculate mean, standard deviation, and peak to 
peak for all plots in the current window. 

Histogram 
Use Analysis > Histogram to generate a histogram of data as shown in Figure 
79 below.  

 

Figure 88: Histogram Window – CO2 

Histogram Window Features: 

• Red Line – A Gaussian function fitted to the histogram. Fitting results of μ 
and σ are shown in the top-left corner of the plot. 
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• Bin – Specifies the number of intervals that the range of values is divided 
into. 

• Normalized – When selected, the sum of the histograms is normalized 
to 1. 

• Save data – Saves histogram data to a CSV file. 

• Save image – Saves the histogram image as a JPEG, PNG, or PDF file. 

Correlation Plot 
Use Analysis > Correlation Plot to plot Y-axis data in one frame versus that in 
the other. This can be used when two or more frames exist in the current Time 
Series Plot window. 

Allan Standard Deviation Plot 
Use Analysis > Allan Standard Deviation Plot to create an Allan Standard 
Deviation plot (versus a standard deviation plot) for data in the current window. 
See Allan Variance Wikipedia page for more information. 

Time Series Viewer View Menu 
Use the View menu to view X-axis information in date-time, minute, or hour 
format.  

 

Figure 89: Time Series Viewer – View Menu 

 

  
NOTE 

When switching from Datetime to Minute or Hour, the X-axis data is subtracted 
from the earliest point shown in the panel and then converted to the desired 
unit. 

The Time Series Viewer Canvas 
The Time Series Viewer canvas (Figure 79 below) is comprised of interactive 
graphs and a variety of configuration options. 

Mouse Options and Graph Transform 
The following mouse actions can be used in the canvas graphs: 

https://en.wikipedia.org/wiki/Allan_variance
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• Left-click and drag: Zooms into the selected area of the plot. 

• Left-click and drag with the SHIFT key down: Pans the plot. 

• Left-click and drag with CTRL key down: Zooms out from the plot. 

• Left-click and drag with ALT key down: Stretches the plot. 

• Right-click: Opens an additional menu. Refer to the Right-click menu 
below in the next section. 

 
Note: this screenshot is for example only. The species shown on your analyzer may vary. 

Figure 90: Time Series Viewer Canvas 

Right-click Menu 
Right-clicking on the canvas opens a pop-up menu:  

 

Figure 91: Canvas Right-click Pop-up Menu 
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Export Image – Exports the current plot as a JPEG, PNG, or PDF file. 

Export Data in Current View – Exports only date/time and the selected variable 
in the current view to an HDF5 or CSV file. 

Export All Data in Current Time Range – Exports all variable columns of the 
selected dataset in the current time range to an HDF5 file. Refer to Concatenate 
H5 Files on Page 108 for more information. 

Edit Plot properties – Opens the Image Editor form (Figure 83), where the 
following options can be specified. 

 

Figure 92: Image Editor Form 

Image Editor Form Options: 

• Title – Edits the title of the plot. 

• Line – Specifies the line pattern of the plot. If None is selected, the data 
points will be plotted without connecting lines. 

• Marker – Specifies the marker type to indicate data points. If None is 
selected, data points will not be shown. 

• x-Axis – Min and Max: Specifies the minimum and maximum date range 
for the X-axis. 

• x[0] – Sets the earliest time of the dataset as the minimum of the X-axis. 

• Time zone – Sets the time zone for date/time variables. This defaults to 
the local time zone. 

• Label – Specify labels for the X-axis and the Y-axis. 

• y-Axis – Min and Max: Specifies the minimum and maximum of data 
displayed on the Y-axis. 
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Dataset Name and Var Name 
An HDF5 file can store one or more tables. Each of these tables is called a 
Dataset. A table can contain one or more columns. Each column is called a 
variable (Var). 

Use the Dataset name drop down (Figure 84) to select the dataset that is used 
for this time series graph. Use the Var name drop down to select the column in 
the dataset to use in the graph. 

 

Figure 93: Time Series Viewer Dataset Options 

Autoscale Y 
When the Autoscale Y option is selected, the Time Series Viewer will autoscale 
on the Y-axis to make sure that all data within the range of the X axis is displayed. 
This feature can make it hard to see small signals when large signals blow the Y 
axis out, so it is often advisable to deselect this checkbox for dynamic or spikey 
datasets. 

Average 
If Block is selected, a block average is calculated when you click the Do average 
button. Otherwise, a moving average is calculated. 

For a block average, Size specifies block size in unit of a minute. For a moving 
average, Size specifies subset size in unit of data points.  

 
REMINDER 

Averaging is performed after the filter and expression are performed. 
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Mean, Std Dev, and Peak to Peak 
The Mean, Std dev (Standard deviation) and Peak to peak fields (Figure 84) 
provide all the statistical information of data in the current view. 

Correlation/XY Plot 
The Correlation/XY Plot window (Figure 85) includes two menu items: File and 
Analysis. For details about the File menu, see Save Configuration on page 116. 

 
REMINDER 

The canvas in this plot is interactive. For details about the plot canvas, see The 
The Time Series Viewer Canvas on page 118. 

 

 

Figure 94: Correlation XY Plot 
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Fitting Menu 
The Fitting menu (Figure 86) includes three options: Fitting, Integration, and 
Statistics. 

 

Figure 95: Fitting Menu 

Fitting allows you to specify one of four fitting methods to include in the 
Correlation/XY plot: 

Linear Fit – Specifies to fit to linear function: 

y = c1x + c0 

Quadratic Fit – Specifies to fit to quadratic function:  

y = c2x2 + c1x + c0 

Polynomial Fit – Specifies to fit polynomial function of degree n:  

y = Σcnxn 

Curve Fit – Specifies to use non-linear least squares to fit an arbitrary function to 
data.  

Analysis Menu 
The Analysis menu has two options: Integration and Statistics. 

 

Figure 96: Analysis Menu 

• Integration – Calculates area under the curve using the composite 
trapezoidal rule. 

• Statistics – Calculates mean, standard deviation, and peak to peak for 
data in the current view.  
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After applying any of the above Analysis options, the results, statistics, or fitting 
function with coefficients are displayed in the lower portion of the Correlation Plot 
window (Figure 88).  

 

Figure 97: Results of Quadratic Fitting 
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APPENDIX F – Setting up Contained 
Exhaust Flow 

F.1 Introduction 
The A2000 vacuum pump is shipped with a noise dampener attached to the 
exhaust port. When a hazardous gas exhaust line from the pump is needed, it 
requires replacing the noise dampener with an adapter that allows a 1/4” OD 
exhaust tubing connection. Use the following instructions when installing a pump 
exhaust line. 

 

Figure 98: A2000 Pump Vacuum and Exhaust Ports 

F.2 Tools and Parts Required 
• Long flathead screwdriver (6” x 5/16” recommended)  

• 9/16” open end wrench  

• Swagelok ISO parallel thread adaptor 1/4"-1/8” SS-400-1-2RS (Picarro PN 
22928) 

• Swagelok gasket SS-2-RS-2V (Picarro PN 22929) 

• 1/4" tubing and stainless-steel ferrule set 

• Snoop leak-detection fluid or similar soap solution 

Vacuum Port 

Exhaust Port with Noise Dampener 
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F.3 Directions 
1. Remove the noise dampener fitting from the bottom of the pump using a 

long flathead screwdriver (Figure 90).  

 

Figure 99: Pump Noise Dampener Removal 

2. Slide the adapter gasket PN 22929 onto the adapter fitting PN 22928 
(Figure 91), screw it into the pump exhaust port, and then tighten it 1/4 
turn using a 9/16” wrench.  

3. Remove the Swagelok nut and ferules from the adapter fitting to ensure 
their orientation is as shown below, then loosely reattach to the adapter. 

4. Slide the 1/4” exhaust tubing into the Swagelok nut and ferules until the 
tubing is fully seated, then using a 9/16" wrench, tighten the nut 
approximately seven flats (420 degrees). 

A guide to this process can be found on the Picarro Video Gallery here: 
https://mktg.picarro.com/acton/media/39674/picarro-video-gallery  

   
 

Figure 100: Pump Exhaust Line Adapter Fittings 

5. With the pump running on room air, apply Snoop leak detection fluid to 
the installed exhaust components to confirm that the system is leak 
tight. Instructions for leak testing using Snoop can be found in this 
video: 

https://vimeo.com/375518688 (go to time 5:20 in the video) 

Adapter Fitting 
PN 22928 

Adapter Gasket 
PN 22929 

Ferule 
Orientation 

Noise Dampener  

https://mktg.picarro.com/acton/media/39674/picarro-video-gallery
https://vimeo.com/375518688
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APPENDIX G – External Valve Sequencer  

G.1 Introduction 
The Picarro analyzer can control two types of valves: 

• Rotary Selector Valve: Digitally controlled valve used to send selected 
flow from one of many inputs (up to 16) into the analyzer. 

• Solenoid Valves: DC voltage powered valve with normally open (NO) and 
normally closed (NC) positions. These can be 2-way or 3-way valves. 

Both types of valves can be simultaneously controlled through a common 
software interface called the External Valve Sequencer (described in section G.7, 
External Valve Sequencer Software Overview) which is available from the Tools 
menu on the GUI. 

Picarro offers two rotary valve and two solenoid valve solutions: 

• A0311 – 16-Port Distribution Manifold. 

• A0311-S – 16-Port Distribution Manifold (Silco) which is optimized for use 
with sticky and reactive gases. 

• S3112 – 3-Way stainless steel solenoid valve with 1/4” fittings. 

• S3136 – 3-Way stainless steel solenoid valve with 1/8” fittings. 

G.2 A0311 16-Port Distribution Manifold 
Compatibility  
The A0311 (Figure 92) is broadly compatible with most Picarro analyzers except 
for those with known surface and chemical compatibility issues (such as the 
G2103, SI2103, SI2108, SI2104, SI2205, G2307, G2509, and PI2114). 

Function 
The A0311 and External Valve Sequencer GUI makes it easy to program the 
sequence and duration of sample intake from various attached sampling lines, 
flasks, or bags. The manifold is controlled using either the Picarro analyzer GUI or 
an external hand-pad (included with the A0311). 

The A0311 samples up to 16 gas sources. During operation, the selected line is 
routed through the valve into the analyzer. The 15 lines that are not selected 
terminate in the valve. 

 

For detailed instructions on integrating the A0311 with your analyzer, refer to the 
16-Port Manifold, User Manual, Including A0311, A0311-S, A0310 (P/N 40-0038). 
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NOTE 
 

       

Figure 101: A0311 – 16-port Distribution Manifold 

G.3 A0311-S 16-Port Distribution Manifold (Silco) 
Compatibility 
The A0311-S (Figure 93) is broadly compatible with all Picarro analyzers but is 
optimized for use with sticky and reactive gases in the following platforms, 
nominally: 

• G2103, SI2103, SI2108, SI2104, SI2205, G2307, G2509, and PI2114 

Function 
For users who require faster response performance, the A0311-S is a 16-Port 
distribution manifold with a flow through valve for reduced memory effects. 
Designed to optimize response time in the presence of reactive gases, the 
A0311-S uses SilcoNert® coated components, PFA tubing, and an additional 
vacuum pump. 

The sampling duration and sequence is easily programmed through the Picarro 
External Valve Sequencer GUI. This design is ideal for fast switching between 
different locations for specialty applications in Semiconductor, Pharmaceutical, 
Environmental research, and other industries.  

 
NOTE 

For detailed instructions on integrating the A0311-S with your analyzer, refer to 
the 16-Port Manifold, User Manual, Including A0311, A0311-S, A0310 (P/N 40-
0038). 
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Figure 102: A0311-S – 16-Port Sequencer – Fast Multiport Gas Sampler 

G.4 Valve Control Configurations 
For all models of Picarro analyzers, the rotary valve control is disabled in the 
factory default setting. The solenoid valve control, however, is enabled by default 
for all solenoid valve connectors.  

To configure an analyzer for operation with an A0311 rotary valve, the user must 
first confirm that the COM port chose on the back of the instrument for connection 
to the rotary valve is consistent with the COM port specified in the Data Manager. 
Refer to section 10.2 COM2 (Data Manager) Data Streaming Protocol for 
instructions to change to rotary valve configuration (the Valve Sequencer MPV 
field) and to ensure the correct COM port is enabled. 

 
CAUTION 

Only use supported 12V, <500 mA, solenoids (listed above in section G.1). Using 
unsupported solenoids may result in damage to the power board. 

G.5 Setting Up Solenoid Valves 
The Valve Sequencer software can control up to six solenoid valves. Each valve 
should operate using 12 VDC with a maximum quiescent current of 500 mA. Most 
analyzers come with a valves cable that can be connected to the solenoid valves, 
and if not, one can be purchased by contacting support@picarro.com. 

 
CAUTION 

Be careful to avoid shorting the solenoid valve output pins, as this will blow the 
relays on the power board, requiring a costly replacement. 

The valve connector cable should be connected to the 15-pin connector at the 
lower left corner of the analyzer. There are six pairs of wires with connectors 
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labeled V1, V2, … V6 with 2-pin female Molex connectors (Molex #43020-0200) 
for connection to the solenoid valves. For valves wired with matching Molex 
connectors, connect V1 to the solenoid valve 1, V2 to solenoid valve 2, etc. Do 
not connect the solenoid valve to the analyzer ground – use only the provided 
electrical connectors. 

G.6 Setting up a Rotary Selector Valve 
The (null modem) 9-pin female connector cable should be attached to its 
corresponding 9-pin male port (COM 2) on the analyzer. The other end of the 
cable connects to the 9-pin port on the A0311. Please note the 9-pin connector 
cable is not supplied with the instrument – only as part of the A0311 kit. 

G.7 External Valve Sequencer Software Overview 
The External Valve Sequencer software allows the user to define a sequence of 
(repeating) steps within which rotary valve positions and/or solenoid valve 
positions can be defined uniquely at each step. 

Opening the Sequencer 
From the CRDS Data Viewer, Users dropdown menu login using your username 
and password. Then, from the Tools drop-down menu, select Show Valve 
Sequencer GUI. The Picarro valve sequencer window displays (Figure 94), but 
typically sitting behind the main GUI. Hitting alt-tab brings the Valve Sequencer 
GUI to the front. 
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Figure 103: Launching the Valve Sequencer GUI 

Valve Sequencer UI Menus 
The sequencer GUI provides the dropdown menu choices shown here. 

      

Figure 104: Valve Sequencer UI Dropdown Menus 

 

 

 

 

 

 



    External Valve Sequencer 
 

132 P/N 40-0103 Rev. A PI5310 UM 

For the following functional descriptions, Figure 96 shows a full view of an 
example sequencer UI. 

 

Figure 105: External Valve Sequencer UI 

The Current Step #, the Remaining Time (min), and the Current Valve State are 
shown in the topmost row of the valve sequencer command window. The duration 
of each step is set in decimal minutes; for example, 15 seconds would be entered 
in as 0.25 minutes. 

While a sequence is inactive, Current Step # will typically read “0.” Once the user 
has selected Start Sequence from the Action menu, or once the user clicks 
Apply from the GUI, the Current Step value will change to 1, corresponding to the 
first step defined below it, and will continue through the steps, returning to Step 1 
once the last step is completed.  

If a user wishes to perform a set of steps only once, they may set a final step with 
a very long duration, or wait until the sequence is finished, and at the end of the 
last step, click Stop Sequence from the Action menu. 

Current step and valve state 
status panel (when sequencer 
is running) 

Sequencer 
configuration controls 
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Under Action, the Go to First Step menu item restarts the sequence from step 1. 
When the first step in the sequence starts, the “Current Step” value will change to 
“1”. This will begin the sequence if the sequence is currently active. 

G.8 Programming and Saving a Valve Sequence 
Each “step” in the sequence can be used to set the rotary valve to a given position 
or activate selected solenoid valve(s) for a set period. Multiple steps can be 
carried out in sequential order to switch between different gas sources, flush out a 
manifold, or to perform other gas handling operations.  

1. Create the number of desired steps in the sequence by clicking the 
up/down arrow for Total Steps. 

2. For each step, select the box for each solenoid valve to be opened. The 
checkmark in the Current Valve State window indicates a solenoid valve 
is set to its “normally closed” value in the case of a 3-way, or to its 
“open” value in the case of a 2-way on/off valve. The positions from left 
to right correspond to solenoid valves V1 to V6. 

3. The rotary selector valve position can be set in the column labeled Rot. 
Valve Code. Enter the number that corresponds to the desired valve 
position. A value of 1 in this field corresponds to position 1 on the rotary 
valve. Only one rotary position can be selected per step.  

4. The upper right box, Current Rot. Valve Code, displays the current value 
while a sequence is active. It should be white if a rotary valve is 
connected, turned on, and detected by the software. If the box is grayed 
out, the rotary valve is not detected (if so, consult your rotary valve 
manual). 

5. For each step, set the desired Duration. This is determined by the value 
entered in the Duration (min) field, where the duration of the step is in 
minutes. If duration values are set to <0.1 minutes, they may not be 
carried out accurately. 

6. The Valve Code column (not used with the rotary valves) is a 
configuration-dependent, read-only display field that shows the total 
state of that particular step in a numerical binary sum of form 2 (Valve 
Number -1). When powered, the following valve values are produced, 
and then added together for the final Valve Code. 

Valve 1 Powered = 2(Valve number-1) = 2(1-1) = 1 

Valve 2 Powered = 2(Valve number-1) = 2(2-1)= 2 

Valve 3 Powered = 2(Valve number-1) = 2(3-1)= 4 

Valve 4 Powered = 2(Valve number-1) = 2(4-1) = 8 

Valve 5 Powered = 2(Valve number-1) = 2(5-1)= 16 

Valve 6 Powered = 2(Valve number-1) = 2(6-1)= 32 
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The maximum displayable value is 63 (=1+2+4+8+16+32), when valves 
1-6 are all powered. All other combinations of valves are unique binary 
sum values which denote the specific combination of any of the six 
valves.  

This Valve Code value active at a particular point in time can be shown 
in the main Picarro software GUI as SolenoidValves or sometimes 
ValveMask (this may require going to Settings > Service Mode > 
password picarro). The Rotary valve code can be displayed as 
MPVPosition. 

Above is a 15 minute valve sequence. It opens 5 minutes for each solenoid valve (#1, #2 and 
#3), and each of rotary valve (#4, #5 and #6). 

Figure 106: Example 15 Minute Sequence 

7. Once the valve sequence has been programmed, it can be saved by 
selecting Save Valve Sequence File under the File menu (Figure 93). 
The sequence may be saved with any name the user chooses.  
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G.9 Loading and Running a Saved Sequence 
Loading a Saved Sequence 

1. Under the File menu, select Load Valve Sequence.  

All the sequence files are in: 

/Home/Picarro/I2000/InstrConfig/ValveSequencer/Name of the Sequence File 

2. To load an existing valve sequence file, select the desired sequence 
name.  

If the user has been running a different sequence from the one that was 
loaded, the user needs to press Run Next Step to initialize the newly 
selected sequence, or alternately go to File > Go To First Step and Start 
Sequencer. 

Running a Sequence 
1. Under the Action menu, select Start Sequencer. 

This selection will change to Stop Sequencer once the sequence starts. 
(The sequencer should be activated if it was disabled, but not necessarily 
to change from one sequence to another.) The sequence will repeat itself 
indefinitely until disabled or the software is exited.  

2. Once the sequencer is running, the user can select Hide Sequencer 
Interface under the Action menu; the sequence will continue to run even 
with the UI hidden, and will automatically continue if the instrument ever 
loses power from the wall and restarts after power is restored. 
(However, the timing of the sequence will be offset relative to the 
intended cadence.)  

3. To bring the sequencer interface back into view, from the main Picarro 
GUI, go to Tools > Show/hide Valve Sequencer again. 

Skipping Steps or Advancing to a Particular Step 
If desired, the valve sequence can be forwarded to the next step of the sequence 
by clicking the Run Next Step button on the UI. To jump to a particular step, 
increment the Run Step # field and click Apply. 

Stopping the Sequencer  
1. Under the Action menu, select Stop Sequencer.  

This will leave all valves in their current state. In some situations, it is 
convenient to program the last step in the sequence to be a safe or 
default valve state.  
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2. Should the user need to put the solenoid or rotary valves into a 
safe/default state, the sequencer can be advanced to the last step using 
the Run Next Step button.  

Resetting Valves 
Under the Action menu, selecting Reset All Valves will deactivate/reset all valves 
to their default state.  

G.10 Scheduling a Sequence 
Users may schedule a sequence to start at a particular time in the future, often at 
the top of the hour, or at midnight for a recurring sequence with an hourly or daily 
cadence. The Schedule Sequence button is typically greyed out when the user 
shows the valve sequencer because the start time has passed. To begin a run in 
the future, select the desired date under Start Date, and the desired time under 
Start Time. When both values are in the future, the Schedule Sequence button will 
become active, and the user may click it. When the scheduled time arrives, the 
sequence will start automatically. 
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APPENDIX H – Relative Humidity 
Conversion 

H2O Concentration (C) is reported in units of parts per hundred or percent (%) and is a 
volumetric fraction of water vapor to total (wet) gas. Via the ideal gas law, the 
concentration can be related to the water vapor pressure (PW) and the total pressure 
(P). 

𝐶𝐶𝑤𝑤𝑤𝑤𝑤𝑤 = 100 ∙
𝑃𝑃𝑊𝑊
𝑃𝑃

 

A popular way to express volumetric concentration when working with humidity is in 
terms of total (dry) gas. 

𝐶𝐶𝑑𝑑𝑑𝑑𝑑𝑑 = 100 ∙
𝑃𝑃𝑊𝑊

(𝑃𝑃 − 𝑃𝑃𝑊𝑊) 

The two concentration definitions can be related by 

𝐶𝐶𝑑𝑑𝑑𝑑𝑑𝑑 = 100 ∙𝐶𝐶𝑤𝑤𝑤𝑤𝑤𝑤
(100−𝐶𝐶𝑤𝑤𝑤𝑤𝑤𝑤)

 or 𝐶𝐶𝑤𝑤𝑤𝑤𝑤𝑤 =
100∙𝐶𝐶𝑑𝑑𝑑𝑑𝑑𝑑

�100+𝐶𝐶𝑑𝑑𝑑𝑑𝑑𝑑�
 

Relative Humidity (RH) is the percentage of water vapor pressure to the saturated water 
vapor pressure (PWS). 

𝑅𝑅𝑅𝑅 = 100 ∙
𝑃𝑃𝑊𝑊
𝑃𝑃𝑊𝑊𝑊𝑊

 

There are several empirically generated equations that provide the saturation vapor 
pressure as a function of temperature (T). A simple and effective relationship for use 
within a temperature range of -45 °C to 60 °C is provided by the Mangus formula with 
coefficients adjusted by Sonntag [1]. 

𝑃𝑃𝑊𝑊𝑊𝑊 = 𝛼𝛼 ∙ 𝑒𝑒�
𝛽𝛽∙𝑇𝑇
𝑇𝑇+𝜆𝜆� 

Where, 𝛼𝛼 = 4.584 Torr, 𝛽𝛽 = 17.62 and λ = 243.12 °C 

Combining the equations shown above yields the final relationship for converting the wet 
and dry definitions of concentration to relative humidity. 

 
For example, a wet concentration of 1.5% H20 at 18.0 °C and 760.0 Torr yields a 
relative humidity of 73.8%. 

A dry concentration of 1.5% at 18.0 °C and 760.0 Torr yields a relative humidity of 
72.7%. 
[1] Sonntag D.: Important New Values of Physical Constants of 1986, Vapour Pressure Formulations based 
on the ITS-90 and Psychrometer Formulae; Z. Meteorol.70 (1990) 5, 340-344 

𝑅𝑅𝑅𝑅 = 𝐶𝐶𝑤𝑤𝑤𝑤𝑤𝑤 ∙
𝑃𝑃
𝛼𝛼 ∙ 𝑒𝑒

−�𝛽𝛽∙𝑇𝑇𝑇𝑇+𝜆𝜆� =  
100 ∙ 𝐶𝐶𝑑𝑑𝑑𝑑𝑑𝑑

�𝐶𝐶𝑑𝑑𝑑𝑑𝑑𝑑 + 100�
∙
𝑃𝑃
𝛼𝛼 ∙ 𝑒𝑒

−�𝛽𝛽∙𝑇𝑇𝑇𝑇+𝜆𝜆� 
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APPENDIX I – Introduction to CRDS 
Technology 

Picarro analyzers use time-based, optical absorption spectroscopy of the target gases to 
determine concentration in a sample. They are based on wavelength-scanned cavity 
ring-down spectroscopy (WS-CRDS), a technology in which light travels many times 
through the sample, creating an exceptionally long effective path length for the light to 
interact with the target gas, thus enabling excellent detection sensitivity in a compact 
and rugged instrument.  

The Picarro analyzer is comprised of two modules: 

• The Analyzer contains the spectrometer, sample chamber, and a computer with a 
hard drive to store and analyze data. The single analyzer module controls the 
operation of the system and converts spectroscopic measurements into gas 
concentration data. 

• The External Vacuum Pump draws the sample gas through the instrument. 

I.1 Cavity Ring-Down Spectroscopy (CRDS) 
Nearly every small gas-phase molecule (e.g., CO2, H2O, H2S, NH3) and 
isotopologue (e.g., H2

18O, 13CO2, 15N14N16O) uniquely absorb specific 
wavelengths of near-infrared light. The strength of the light absorption is related to 
the concentration of a molecule in a sample and the distance that light travels 
through the sample, called the path length.  

Conventional infrared spectrometers are typically only sensitive enough to detect 
trace gases at levels in the part-per-million. Cavity Ring-Down Spectroscopy 
(CRDS), on the other hand, is one thousand to one million more times sensitive.  

The increased sensitivity of CRDS is due to the design of the sample cavity and 
the time-based measurement. In the cavity, a series of mirrors reflects the infrared 
light through the sample, increasing the path length. For a Picarro cavity of only 
25 cm in length, the effective path length of the cavity can be over 20 kilometers.  

In Picarro analyzers, light from a single-frequency laser enters a cavity where 
three mirrors reflect the laser light as seen in Figure 99. The light enters through 
the mirror closest to the laser, bounces off the angled mirror in the lower right 
corner of the cavity, travels to the hemispherical mirror at the top of the cavity, 
bounces toward the mirror in the lower left corner of the cavity, and then returns to 
the first mirror. This motion becomes a continuous traveling light wave, which is 
represented by the dark orange path in Figure 98. 
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Figure 107: Schematic of Picarro CRDS Analyzer Cavity 

When the laser is on, the cavity quickly fills with laser light. A small amount of 
laser light is transmitted through the mirror closest to the photodetector, which 
turns the incident light into a signal that is directly proportional to the light intensity 
in the cavity. 

When the photodetector signal reaches a threshold level (in a few tens of 
microseconds), the laser is turned off. The light contained within the cavity 
continues to bounce between the mirrors (about 40,000 times). Since the mirrors 
have slightly less than 100% reflectivity (99.999%), the light inside the cavity 
steadily leaks out of the cavity. The intensity of the light reaching the detector 
decreases, falling exponentially until it reaches zero. This decay, or “ring-down,” is 
measured in real time by the photodetector. 

I.2 Relating Ring-Down Time to Absorption Intensity 
The time it takes to ring-down is inversely related to the total optical loss in the 
cavity, including the strength of molecular absorption at a given wavelength of 
light. For an empty cavity, the time it takes for the intensity to decrease by a given 
percent is determined solely by the reflectivity of the mirrors. A cavity containing 
gas that absorbs light will have a shorter ring-down time than an empty cavity. As 
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the light circulates in a cavity with a gas sample, the molecular absorption by the 
gas results in a decrease of the light intensity. 

Determining absorption intensity at a specific wavelength requires comparing the 
ring-down time of an empty cavity to the ring-down time of a cavity that contains 
gas (Figure 99). A cavity can be empty if it contains no gas; it will also appear 
empty if the molecules of the sample inside the cavity do not interact with the 
specific wavelength of light.  

Picarro instruments gather measurements from an “empty” cavity by switching the 
light to wavelengths that are not absorbed by the target molecules. The analyzer 
subsequently measures ring-down times at wavelengths that are absorbed by the 
target gas. The analyzer automatically and continuously compares these two 
types of ring-down times, and the software uses those comparisons to calculate 
absorption intensities. 

 

Figure 108: Light Intensity as Function of Time in CRDS System 

I.3 Converting Absorption Intensity to 
Concentration 

Plotting the absorbance at each measured wavelength generates an optical 
spectrum. This spectrum contains absorbance peaks that are unique to each 
molecule in the sample. The height of a particular absorption peak is proportional 
to the concentration of a molecule that generated the signal.  
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The height of the peak is calculated by subtracting the maximal absorbance from 
the baseline absorbance. Figure 100 shows a plot of ideal optical spectra with a 
clean, uniform baseline on either side of the absorption peak. 

 

Figure 109: Absorption Spectral Curve 

However, optical spectra often contain several absorption lines, nested closely 
together. A particular absorption peak may be visible between lines, but the 
absorption may not return to the baseline before it rises in response to another 
molecule.  

Picarro analyzers calculate the baseline underneath a poorly resolved peak by 
modeling the absorption peaks from other surrounding molecules and subtracting 
contributions from neighboring peaks to the absorption intensity.  

I.4 Spectral Precision and High Sensitivity 
Measurements 

Picarro analyzers contain two features that provide high spectral precision:  

• A proprietary wavelength monitor (WLM) that measures the absolute laser 
wavelength to a precision that is a few orders of magnitude narrower than 
the spectral linewidth: Picarro’s patented WLM measures absolute laser 
wavelength to a precision more than 1,000 times narrower than the 
observed Doppler-broadened linewidth for small gas-phase molecules. 
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The instruments lock the laser to the WLM, and then the monitor tunes to 
wavelengths known to be maximally and minimally absorbed by the target 
molecule. The result is closely clustered absorption intensities, measured 
at wavelengths just before peak absorption, at peak absorption, and just 
after peak absorption, as the absorbance returns to the baseline.  

• Precise temperature and pressure control in the sample cavity: Accurate 
absorption measurements at precisely known wavelengths account for 
little unless the temperature and pressure of the CRDS measurement 
cavity are known. The observed line intensity and shape depend on the 
temperature and pressure inside the sample cavity. Small temperature 
and pressure instabilities can result in large concentration errors due to 
fluctuating peak heights and baselines. To completely minimize instrument 
measurement drift, temperature and pressure must be actively stabilized 
to constant values.  

For precise temperature control, the sample cavity is surrounded by layers of 
thermally insulating material to provide a high degree of passive thermal stability. 
The cavity is further actively stabilized by means of a solid-state heating system 
locked to the output of a thermal sensor. This enables the temperature of the 
cavity to be within 20 mK of the set temperature.  

For precise pressure control, the cavity pressure is monitored using a high-
linearity pressure transducer. The system computer uses this pressure data in a 
feedback loop to control proportional valves that adjust the inlet and outlet gas 
flow of the cavity. 
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APPENDIX J – SDS for Koolance LIQ-702 
A PDF copy of this SDS from Koolance is available at koolance.com. 

 

 

https://koolance.com/files/products/manuals/Koolance_LIQ-702_SDS_(English).pdf
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APPENDIX K – Limited Warranty 
Picarro, Inc. warrants its Products to be free from defects in material and workmanship 
and to perform in the manner and under the conditions specified in the Product 
specifications for twelve (12) months from shipment. 

This warranty is the only warranty made by Picarro with respect to its Products and no 
person is authorized to bind Picarro for any obligations or liabilities beyond this warranty 
in connection with its Products. This warranty is made to the original Purchaser only, is 
non-transferable and may only be modified or amended by a written instrument signed 
by a duly authorized officer of Picarro. Sub-systems manufactured by other firms, but 
integrated into Picarro Products, are covered by the original manufacturer’s warranty 
and Picarro makes no warranty, express or implied, regarding such sub-systems. 
Products or parts thereof which are replaced or repaired under this warranty are 
warranted only for the remaining, un-expired portion of the original warranty period 
applicable to the specific Product replaced or repaired. 

WARRANTY DISCLAIMER 

THE FOREGOING WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER 
WARRANTIES WHETHER WRITTEN, ORAL, OR IMPLIED, AND SHALL BE THE 
PURCHASER’S SOLE REMEDY AND PICARRO’S SOLE LIABILITY IN CONTRACT 
OR OTHERWISE FOR THE PRODUCT. PICARRO EXPRESSLY DISCLAIMS ANY 
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE. 

The Purchaser’s exclusive remedy with respect to any defective Product shall be to have 
Picarro repair or replace such defective Product or credit the Purchaser’s account, 
whichever Picarro may elect in its sole discretion. If it is found that any Product has been 
returned which is not defective, the Purchaser will be notified, and such Product returned 
at the Purchaser’s expense. In addition, a charge for testing and examination may, at 
Picarro’s sole discretion, be made on any Product so returned. 

These remedies are available only if: 1) Picarro is notified in writing by the Purchaser 
promptly upon discovery of a Product defect, and in any event within the warranty 
period; 2) Picarro’s examination of such Product discloses to Picarro’s satisfaction that 
such defects actually exist and the Product has not been repaired, worked on, altered by 
persons not authorized by Picarro, subject to misuse, negligence or accident, or 
connected, installed, used or adjusted otherwise than in accordance with the instructions 
furnished by Picarro. 

The following warranty conditions shall apply to all Picarro, Inc. products unless 
amended by a written instrument signed by a duly authorized officer of Picarro: 

ADJUSTMENT – No electrical, mechanical, or optical adjustments to the product(s) are 
permitted. 
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PARTS AND LABOR - New or factory-built replacements for defective parts will be 
supplied for twelve (12) months from date of shipment of the product. Replacement parts 
are warranted for the remaining portion of the original warranty period. There will be no 
charge for repair of products under warranty where the repair work is done by Picarro, 
Inc.  

NOT COVERED BY THE WARRANTY – Damage to any optical surface from improper 
handling or cleaning procedures. This applies specifically to those items subjected to 
excess laser radiation, contaminated environments, extreme temperature, or abrasive 
cleaning. Damage due to ESD, abuse, misuse, improper installation or application, 
alteration, accident, negligence in use, improper storage, transportation, or handling. No 
warranty shall apply where the original equipment identifications have been removed, 
defaced, altered or where there is any evidence of alterations, adjustments, removal of 
protective outer enclosure, any attempt to repair the product by unauthorized personnel 
or with parts other than those provided by Picarro, Inc.  

CLAIMS ASSISTANCE - Call Picarro, Inc. Customer Service or your local distributor for 
assistance. Give our representative the full details of the problem. Helpful information or 
shipping instructions will be provided. If requested, estimates of the charges for non-
warranty or other service work will be supplied before work begins. 

RETURN PROCEDURE - Customers must obtain a Return Merchandise Authorization 
Number from Picarro, Inc. prior to returning units. Products being returned for repair 
must be shipped in their original shipping cartons to avoid damage. 

 



 

 

 
 
 

 
 
 

 

About Picarro 
Picarro is a leading provider of solutions to measure greenhouse gas (GHG) concentrations, 
trace gases, and stable isotopes across many scientific applications, along with the energy and 
utilities markets. Our patented Cavity Ring-Down Spectroscopy (CRDS) is at the heart of all 
Picarro instruments and solutions, enabling the detection of target molecules at part per billion or 
better resolution. 

Product Support 
Utilize Picarro support resources for product support. Join the Picarro community to ask 
questions and get answers, search the document library for datasheets and user manuals, 
download software, and purchase products and replacement parts.  

 

Access to online User Manuals is available to all registered Picarro customers with login 
credentials. If you do not yet have an account, please email us at support@picarro.com 
to request access. Note must be a registered user and logged in to access the following 
resources: 

• Picarro Document Library 

• Picarro Community (Forums) 

• Picarro Software Downloads 

• Picarro Literature (Scientific Resources) 

• Picarro Web Store 

 
Contact Picarro for questions regarding specific applications and additional information. 

US Technical Support:  International Technical 
Support: 

 Customer Service: 

Email: support@picarro.com   Email: support@picarro.com  Email: support@picarro.com 

Phone: +1 408 962 3991  Phone: +31 85 888 1650  Phone: +1 408 962 3992 
 

https://www.picarro.com/support/documents
https://www.picarro.com/support/community
https://www.picarro.com/support/downloads
https://www.picarro.com/support/literature
https://www.picarro.com/support/literature
mailto:support@picarro.com
mailto:support@picarro.com
mailto:support@picarro.com
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